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1 Product Overview

About MATLAB Coder

MATLAB® Coder™ generates standalone C and C++ from MATLAB® code.
The generated source code is portable and readable. MATLAB Coder supports
a subset of core MATLAB language features, including program control
constructs, functions, and matrix operations. It can generate MEX functions
that let you accelerate computationally intensive portions of MATLAB code
and verify the behavior of the generated code.

When to Use MATLAB Coder
Use MATLAB Coder to:

® Generate readable, efficient, standalone C/C++ code from MATLAB code.
® Generate MEX functions from MATLAB code to:

= Accelerate your MATLAB algorithms.

= Verify generated C code within MATLAB.
¢ Integrate custom C/C++ code into MATLAB.

What You Can Do with the Project Interface
¢ Specify the MATLAB files from which you want to generate code

® Specify the data types for the inputs to these MATLAB files
® Select an output type:
= MEX function
= (C/C++ Static Library
= C/C++ Executable
¢ Configure build settings to customize your environment for code generation

¢ Open the code generation report to view build status, generated code,

and compile-time information for the variables and expressions in your
MATLAB code
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About MATLAB® Coder™

See Also

e “Setting Up a MATLAB Coder Project”

e Chapter 2, “Tutorial: Generating C Code from MATLAB Code Using the
MATLAB® Coder Project Interface”

When to Use the Command Line (codegen function)

® Your MATLAB source code uses the assert command to specify the types
on input parameters. MATLAB Coder projects do not currently support
assert statements in MATLAB code.

® You use build scripts to specify input parameter types and code generation
options.

See Also

¢ The codegen function reference page

e Chapter 3, “Tutorial: Generating C Code from MATLAB Code at the
Command Line”

¢ Chapter 4, “Tutorial: Generating MEX Functions from MATLAB Code at
the Command Line”
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1 Product Overview

Code Generation for Embedded Software Applications

The Embedded Coder™ product extends the MATLAB Coder product with
features that are important for embedded software development. Using the
Embedded Coder add-on product, you can generate code that has the clarity
and efficiency of professional handwritten code. For example, you can:

® Generate code that is compact and fast, which is essential for real-time
simulators, on-target rapid prototyping boards, microprocessors used in
mass production, and embedded systems.

e Customize the appearance of the generated code.
e Optimize the generated code for a specific target environment.
® Enable tracing options that help you to verify the generated code.

® (Generate reusable, reentrant code.

See Also

e “MATLAB Tutorials” in the Embedded Coder documentation.



Code Generation for Fixed-Point Algorithms

Code Generation for Fixed-Point Algorithms
Using the Fixed-Point Toolbox™ product, you can generate:

e MEX functions to accelerate fixed-point algorithms.

¢ Fixed-point code that provides a bit-wise accurate match to MEX function
results.

1-5



1 Product Overview

Installing Prerequisite Products

To generate C/C++ code using MATLAB Coder, you must install the following
products:

e MATLAB

e MATLAB Coder

e C/C++ compiler

For a list of supported compilers, see
http://www.mathworks.com/support/compilers/current_release/.

You must set up the compiler before generating code. See “Setting Up the
C/C++ Compiler” on page 1-8.

For instructions on installing MathWorks® products, see the MATLAB
installation documentation for your platform. If you have installed MATLAB
and want to check which other MathWorks products are installed, enter ver
in the MATLAB Command Window.
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Related Products

Related Products

e Embedded Coder

¢ Simulink® Coder™
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1 Product Overview

Setting Up the C/C++ Compiler

Before using MATLAB Coder, you must set up your C/C++ compiler by
running the mex -setup command, as described in the documentation for
mex in the MATLAB Function Reference. You must run this command even
if you use the default C compiler that comes with the MATLAB product for
Microsoft® Windows® platforms. You can also use mex to choose and configure
a different C/C++ compiler, as described in “Building MEX-Files” in the
MATLAB External Interfaces documentation.

1-8



Expected Background

Expected Background

You should be familiar with :

e MATLAB software
e MEX functions

For more information, see “Introducing MEX-Files” in the MATLAB
External Interfaces documentation.

e (C/C++ programming concepts

To generate C code on embedded targets, you should also be familiar with how
to re-compile the generated code in the target environment.

To integrate the generated code into external applications, you should be
familiar with the C/C++ compilation and linking process.



1 Product Overview
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Workflow Overview

e “Setting Up a MATLAB Coder Project”
¢ “Preparing MATLAB Code for C/C++ Code Generation”
® “Testing MEX Functions in MATLAB”

® “Generating C/C++ Code from MATLAB Code”

o “Accelerating MATLAB Algorithms”

® “Code Optimization”

* “How to Accelerate MATLAB Algorithms”

Cptimize
Genarated Code [~
Generate
o Ciom it om gsg:—g[':g ¥ Bp|05'§29|’2[8
MATLAB Code )
v
Frepare MATLAB Test MEX
Se(}toggrh;fJ:;B » Code for Code Function in
l Generatian MATLAB
Iy
Accelarate Use MEX
> MATLAB Speed OK? ¥ Function
Algorithm P
Optimize MEX | N
Function
See Also




Running MATLAB® Coder™ Demos

Running MATLAB Coder Demos

MATLAB Coder Demos About Generating C Code

The MATLAB Coder product ships with the following demos that show how to
generate standalone C code from MATLAB code.

Demo...

Shows How You Can...

Averaging Filter

To run the demo, at the MATLAB command line,
enter:

showdemo coderdemo_averaging filter

Generate a standalone C library from
MATLAB code using codegen

Edge Detection on Images

To run the demo, at the MATLAB command line,
enter:

coderdemo_edge_detection

Generate a standalone C library from
MATLAB code that implements a Sobel
filter

Read Text File

To run the demo, at the MATLAB command line,
enter:

showdemo coderdemo_readfile

Generate a standalone C library from
MATLAB code that uses the coder.ceval,
coder.extrinsic and coder.opaque
functions.

“Atoms” Simulation

To run the demo, at the MATLAB command line,
enter:

showdemo coderdemo_atoms

Generate a standalone C library and
executable from MATLAB code using a
code generation configuration object to
enable dynamic memory allocation

Replacing Math Functions and Operators

To run the demo, at the MATLAB command line,
enter:

showdemo coderdemo_tfl

Use target function libraries (TFLs) to
replace operators and functions in the
generated code

Note To run this demo, you need
Embedded Coder software.

Kalman Filter

To run the demo, at the MATLAB command line,
enter:

showdemo coderdemo_kalman_filter

® Generate a standalone C library from a
MATLAB version of a Kalman filter

e Accelerate the Kalman filter algorithm
by generating a MEX function
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1 Product Overview

MATLAB Coder Demos About Generating MEX
Functions

The MATLAB Coder product ships with the following demos that show how
to generate MEX functions from MATLAB code.

Demo... Shows How You Can...

Hello World Generate and run a MEX function from a simple
To view the demo, at the MATLAB MATLAB program

command line, enter:

showdemo coderdemo_hello_world

Working with Persistent Variables Compute the average for a set of values by using
To view the demo, at the MATLAB persistent variables

command line, enter:

showdemo coderdemo_persistent

Working with Structure Arrays Shows how to build a scalar template before growing it
To run the demo, at the MATLAB into a structure array, a requirement for code generation
command line, enter: from MATLAB.

showdemo coderdemo_struct_array

Balls Simulation Simulates bouncing balls and shows that you should

To run the demo, at the MATLAB specify only the entry function when you compile the
command line, enter: application into a MEX function.

showdemo

coderdemo_bouncing balls

General Relativity with MATLAB Uses Einstein’s theory of general relativity to calculate
Coder geodesics in curved space-time.

To run the demo, at the MATLAB
command line, enter:

showdemo coderdemo_gr

1-12
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® “Learning Objectives” on page 2-2

e “Tutorial Prerequisites” on page 2-3

¢ “Example: The Kalman Filter” on page 2-4
¢ “Files for the Tutorial” on page 2-7
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e “Tutorial Steps” on page 2-11
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¢ “Learn More” on page 2-34



2 Tutorial: Generating C Code from MATLAB® Code Using the MATLAB® Coder™ Project Interface

Learning Objectives

In this tutorial, you will learn how to:

¢ Create and set up a MATLAB Coder project.

e Automatically generate a MEX function from your MATLAB code and
use this MEX function to validate your algorithm in MATLAB before
generating C code.

¢ Automatically generate C code from your MATLAB code.
® Define function input properties.

® Specify variable-size inputs when generating code.

® Specify code generation properties.

® Generate a code generation report that you can use to debug your MATLAB
code and verify that it is suitable for code generation.



Tutorial Prerequisites

Tutorial Prerequisites

In this section...
“What You Need to Know” on page 2-3

“Required Products” on page 2-3

What You Need to Know

To complete this tutorial, you should have basic familiarity with MATLAB
software.

Required Products

To complete this tutorial, you must install the following products:

e MATLAB
e MATLAB Coder
¢ C compiler (for most platforms, a default C compiler is supplied with

MATLAB)

For a list of supported compilers, see
http://www.mathworks.com/support/compilers/current_release/.

You must set up the C compiler before generating C code. See “Setting Up
Your C Compiler” on page 3-13.

For instructions on installing MathWorks products, see the MATLAB
installation documentation for your platform. If you have installed MATLAB
and want to check which other MathWorks products are installed, enter ver
in the MATLAB Command Window.
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2 Tutorial: Generating C Code from MATLAB® Code Using the MATLAB® Coder™ Project Interface

2-4

Example: The Kalman Filter

In this section...

“Description” on page 2-4
“Algorithm” on page 2-4
“Filtering Process” on page 2-5

“Reference” on page 2-6

Description

This section describes the example used by the tutorial. You do not have to be
familiar with the algorithm to complete the tutorial.

The example for this tutorial uses a Kalman filter to estimate the position
of an object moving in a two-dimensional space from a series of noisy inputs
based on past positions. The position vector has two components, x and vy,
indicating its horizontal and vertical coordinates.

Kalman filters have a wide range of applications, including control, signal
and image processing; radar and sonar; and financial modeling. They are
recursive filters that estimate the state of a linear dynamic system from a
series of incomplete or noisy measurements. The Kalman filter algorithm
relies on the state-space representation of filters and uses a set of variables
stored in the state vector to characterize completely the behavior of the
system. It updates the state vector linearly and recursively using a state
transition matrix and a process noise estimate.

Algorithm

This section describes the algorithm of the Kalman filter and is implemented
in the MATLAB version of the filter supplied with this tutorial.

The algorithm predicts the position of a moving object based on its past
positions using a Kalman filter estimator. It estimates the present position
by updating the Kalman state vector, which includes the position (x and y),
velocity (Vx and Vy), and acceleration (Ax and Ay) of the moving object. The
Kalman state vector, x_est, is a persistent variable.



Example: The Kalman Filter

% Initial conditions
persistent x_est p_est
if isempty(x_est)
x_est = zeros(6, 1);
p_est = zeros(6, 6);
end

x_est is initialized to an empty 6x1 column vector and updated each time
the filter is used.

The Kalman filter uses the laws of motion to estimate the new state:

X=X, +Vxdt
Y =Y, +Vy.dt
Vx = Vxy + Ax.dt
Vy =Vyy + Ay.dt

These laws of motion are captured in the state transition matrix A, which is a
matrix that contains the coefficient values of x, y, V,, vy, A, and A,

% Initialize state transition matrix
dt=1;
A=[ 1

o O o oo
[N eNeNel o)

Filtering Process

The filtering process has two phases:

® Predicted state and covariance

The Kalman filter uses the previously estimated state, x_est, to predict the
current state, x_prd. The predicted state and covariance are calculated in:

% Predicted state and covariance

X_prd = A * x_est;
p_prd = A * p_est * A" + Q;

2-5



2 Tutorial: Generating C Code from MATLAB® Code Using the MATLAB® Coder™ Project Interface

e Estimation

The filter also uses the current measurement, z, and the predicted state,
Xx_prd, to estimate a more accurate approximation of the current state. The
estimated state and covariance are calculated in:

o°

Measurement matrix
=[100000; 010000 ];
= eye(6);

1000 * eye(2);

T O I
|

o°

Estimation

=H * p_prd" * H' + R;
=H * p_prd';

_gain = (S \ B)';

x W0 »w
[
3

% Estimated state and covariance
x_est = x_prd + klm_gain * (z - H * x_prd);
p_est = p_prd - klm_gain * H * p_prd;

% Compute the estimated measurements
y = H * x_est;

Reference

Haykin, Simon. Adaptive Filter Theory. Upper Saddle River, NJ:
Prentice-Hall, Inc., 1996.



Files for the Tutorial

Files for the Tutorial

In this section...
“About the Tutorial Files” on page 2-7

“Location of Files” on page 2-7

“Names and Descriptions of Files” on page 2-8

About the Tutorial Files

The tutorial uses the following files:

¢ Example MATLAB code files for each step of the tutorial.

Throughout this tutorial, you work with MATLAB files that contain a
simple Kalman filter algorithm.

¢ Build scripts that you use to compile your function code.
e Test files that:

= Perform the preprocessing functions.

= Call the Kalman filter.

= Perform the post-processing functions.

e A MAT-file that contains input data.

Location of Files

The tutorial files are available in the following folder:
docroot\toolbox\coder\examples\kalman. To run the tutorial,

you must copy these files to a local folder. For instructions, see “Copying
Files Locally” on page 3-11.

2-7



2 Tutorial: Generating C Code from MATLAB® Code Using the MATLAB® Coder™ Project Interface

Names and Descriptions of Files

Type Name Description
Function | kalmanO1.m Baseline MATLAB implementation of a
code scalar Kalman filter.
kalman02.m Version of the original algorithm that is
suitable for code generation.
kalman03.m Kalman filter suitable for use with
frame-based and packet-based inputs.
Test test01 _ui.m Tests the scalar Kalman filter and plots
scripts the trajectory.
test02_ui.m Tests MEX function for the original
Kalman filter and plots the trajectory.
test03 ui.m Tests the frame-based Kalman filter.
test04_ui.m Tests the variable-size (packet-based)
Kalman filter.
MAT-file | position.mat Contains the input data used by the
algorithm.
Plot plot_trajectory.m Plots the trajectory of the object and the
function Kalman filter estimated position.




Design Considerations When Writing MATLAB® Code for Code Generation

Design Considerations When Writing MATLAB Code for

Code Generation

When writing MATLAB code that you want to convert into efficient,
standalone C/C++ code, you must consider the following:

® Data types

C and C++ use static typing. To determine the types of your variables before
use, MATLAB Coder requires a complete assignment to each variable.

® Array sizing

Variable-size arrays and matrices are supported for code generation. You
can define inputs, outputs, and local variables in MATLAB functions to
represent data that varies in size at run time.

® Memory

You can choose whether the generated code uses static or dynamic memory
allocation.

With dynamic memory allocation, you potentially use less memory at the
expense of time to manage the memory. With static memory, you get best
speed performance, but with higher memory usage. Most MATLAB code
takes advantage of the dynamic sizing features in MATLAB, therefore
dynamic memory allocation typically enables you to generate code from
existing MATLAB code without modifying it much. Dynamic memory
allocation also allows some programs to compile successfully even when
upper bounds cannot be found.

Static allocation reduces the memory footprint of the generated code, and
therefore is suitable for applications where there is a limited amount of
available memory, such as embedded applications.

® Speed

Because embedded applications must run in real time, the code must be
fast enough to meet the required clock rate.

To improve the speed of the generated code:

= Choose a suitable C/C++ compiler. The default compiler that MathWorks
supplies with MATLAB for Windows 32-bit platforms is not a good
compiler for performance.
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2 Tutorial: Generating C Code from MATLAB® Code Using the MATLAB® Coder™ Project Interface

2-10

= Consider disabling run-time checks.

By default, for safety, the code generated for your MATLAB code contains
memory integrity checks and responsiveness checks. Generally, these
checks result in more generated code and slower simulation. Disabling
run-time checks usually results in streamlined generated code and faster
simulation. Disable these checks only if you are sure that your code is
safe and that array bounds and dimension checking is unnecessary.

See Also
® “About Code Generation from MATLAB Algorithms” in the Code
Generation from MATLAB documentation

® “Defining MATLAB Variables for C/C++ Code Generation” in the Code
Generation from MATLAB documentation

¢ “How Working with Variable-Size Data is Different for Code Generation” in
the Code Generation from MATLAB documentation.

¢ “Bounded Versus Unbounded Variable-Size Data” in the Code Generation
from MATLAB documentation

¢ “Enabling and Disabling Dynamic Memory Allocation”

¢ “Controlling Run-Time Checks”



Tutorial Steps

Tutorial Steps

In this section...

“Copying Files Locally” on page 2-11

“Running the Original MATLAB Code” on page 2-12

“Setting Up Your C Compiler” on page 2-13

“Making the MATLAB Code Suitable for Code Generation” on page 2-14
“Setting Up a MATLAB® Coder Project” on page 2-17

“Generating a MEX Function Using MATLAB® Coder” on page 2-19
“Validating the MEX Function” on page 2-20

“Generating C Code Using MATLAB® Coder” on page 2-21

“Comparing the Generated C Code to Original MATLAB Code” on page 2-22
“Modifying the Filter to Accept a Fixed-Size Input” on page 2-23

“Modifying the Filter to Accept a Variable-Size Input” on page 2-29

Copying Files Locally

Copy the tutorial files to a local working folder:

1 Create alocal solutions folder, for example, c: \coder\kalman\solutions.

2 Change to the docroot\toolbox\coder\examples folder. At the MATLAB
command line, enter:

cd(fullfile(docroot, 'toolbox', 'coder', 'examples'))

3 Copy the contents of the kalman subfolder to your local solutions folder,
specifying the full path name of the solutions folder:

copyfile('kalman', 'solutions')

Your solutions folder now contains a complete set of solutions for the
tutorial. If you do not want to perform the steps for each task in the
tutorial, you can view the solutions to see how the code should look.
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2 Tutorial: Generating C Code from MATLAB® Code Using the MATLAB® Coder™ Project Interface

4 Create a local work folder, for example, ¢: \coder\kalman\work.

5 Copy the following files from your solutions folder to your work folder.

kalmanO1.m
® position.mat
® Test scripts test01_ui.m through test04 ui.m

® plot_trajectory.m

Your work folder now contains all the files that you need to get started
with the tutorial.

Running the Original MATLAB Code

In this tutorial, you work with a MATLAB function that implements a Kalman
filter algorithm, which predicts the position of a moving object based on its
past positions. Before generating C code for this algorithm, you make the
MATLAB version suitable for code generation and generate a MEX function.
Then you test the resulting MEX function to validate the functionality of the
modified code. As you work through the tutorial, you refine the design of the
algorithm to accept variable-size inputs.

First, use the script test01_ui.m to run the original MATLAB function to
see how the Kalman filter algorithm works. This script loads the input data
and calls the Kalman filter algorithm to estimate the location. It then calls a
plot function, plot_trajectory, which plots the trajectory of the object and
the Kalman filter estimated position.

1 Set your MATLAB current folder to the work folder that contains your files
for this tutorial. At the MATLAB command line, enter:

cd work

where work is the full path name of the work folder containing your files.
For more information, see “Using the Current Folder Browser” in the
MATLAB Desktop Tools and Development Environment documentation.

2 At the MATLAB command line, enter:

testO1_ui

2-12



Tutorial Steps

short time for the estimated position to converge with the actual position
of the object. Then three sudden shifts in position occur—each time the

Kalman filter estimated position in green. Initially, you see that it takes a
Kalman filter readjusts and tracks the object after a few iterations.

The test script runs and plots the trajectory of the object in blue and the

Trajectory of object [blue] its Kalman estimate[green]
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you must set up your C compiler. For most platforms, MathWorks supplies

a default compiler with MATLAB. If your installation does not include a
default compiler, for a list of supported compilers for the current release of

Before using MATLAB Coder to compile the Kalman filter example code,

Setting Up Your C Compiler

-0.5



2 Tutorial: Generating C Code from MATLAB® Code Using the MATLAB® Coder™ Project Interface

2-14

MATLAB, see http://www.mathworks.com/support/compilers/current_release/
and install a compiler that is suitable for your platform.

To set up the installed compiler:

1 At the MATLAB command line, enter:

mex -setup

2 Enter y to see the list of installed compilers.
3 Select a supported compiler.

4 Enter y to verify your choice.

Making the MATLAB Code Suitable for Code
Generation

® “Considerations for Making Your Code Suitable for Code Generation” on
page 2-14

¢ “Making Your Code Suitable for Code Generation” on page 2-16
¢ “Where to Go Next” on page 2-17

Considerations for Making Your Code Suitable for Code
Generation

Designing for Code Generation. Before generating code, you must
prepare your MATLAB code for code generation. The first step is to eliminate
unsupported constructs.

Checking for Violations at Design Time. You use the code analyzer in
the MATLAB Editor to check for code violations at design time, minimizing
compilation errors. The code analyzer continuously checks your code as you
enter it. It reports problems and recommends modifications to maximize
performance and maintainability.

To use the code analyzer to identify warnings and errors specific to MATLAB
for code generation, you must add the %#codegen directive (or pragma) to your
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MATLAB file. A complete list of MATLAB for Code Generation code analyzer
messages 1s available in the MATLAB Code Analyzer preferences. See “Using
the MATLAB Code Analyzer Report” for more details.

Note The code analyzer might not detect all MATLAB for code generation
issues. After eliminating any errors or warnings that the code analyzer
detects, compile your code with MATLAB Coder to determine if the code has
other compliance issues.

Checking for Violations at Code Generation Time. You can use
MATLAB Coder to check for violations at code generation time. MATLAB
Coder checks that your MATLAB code is suitable for code generation, as
described in “About Code Generation from MATLAB Algorithms” in the Code
Generation from MATLAB documentation.

When MATLAB Coder detects errors or warnings, it automatically generates
an error report that describes the issues and provides links to the offending
MATLAB code. For more information, see “Code Generation Reports” .

After successful code generation, MATLAB Coder generates a MEX function
that you can use to test your implementation in MATLAB.

Checking for Violations at Run Time. You can use MATLAB Coder to
generate a MEX function and check for violations at run time. The MEX
function generated for your MATLAB functions includes run-time checks.
Disabling run-time checks and extrinsic calls usually results in streamlined
generated code and faster simulation. Disabling run-time checks allows

bugs in your code to crash MATLAB. For more information, see “Controlling
Run-Time Checks”.

If you encounter run-time errors in your MATLAB functions, a run-time stack
appears automatically in the MATLAB Command Window. See “Debugging
Run-Time Errors”.
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Making Your Code Suitable for Code Generation

To modify the code yourself, work through the exercises in this section.
Otherwise, open the supplied file kalman02.m in your solutions subfolder to
see the modified algorithm.

To begin the process of making your MATLAB code suitable for code
generation, you work with the file kalman01.m. This code is a MATLAB
version of a scalar Kalman filter that estimates the state of a dynamic system
from a series of noisy measurements.

1 Set your MATLAB current folder to the work folder that contains your files
for this tutorial. At the MATLAB command line, enter:

cd work

where work is the full path name of the work folder containing your files.
See “Using the Current Folder Browser” in the MATLAB Desktop Tools
and Development Environment documentation for more information.

2 Open kalmanO1.min the MATLAB Editor. At the MATLAB command
line, enter:

edit kalmanOi1.m

Tip Before modifying your code, it is best practice to preserve the current
version by backing it up.

The file opens in the MATLAB Editor. The code analyzer message indicator
in the top right corner of the MATLAB Editor is green, which indicates that
it has not detected any errors, warnings, or opportunities for improvement
in the code.

3 Turn on MATLAB for code generation error checking by adding the
%#codegen directive after the function declaration.

function y = kalmanO1(z) %#codegen

The code analyzer message indicator remains green, indicating that it has
not detected any code generation related issues.
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i - : -
function ¥ = kalmanil (z) FFcodegen -
% Initialize state transition matrix
de=1;
A=[ 1 0dc © 0 O;... =
010 de 0 Or...
001 0dc Or...
00010 de:...
000010 ;...
00O0O0O01]:

For more information on using the code analyzer, see “Using the MATLAB
Code Analyzer Report” in the MATLAB Desktop Tools and Development
documentation.

4 Save the file.

You are now ready to compile your code using MATLAB Coder. By
default, MATLAB Coder checks that your MATLAB code is suitable for
code generation, as described in “About Code Generation from MATLAB
Algorithms”. Then, after successful compilation, it generates a MEX
function that you can test in MATLAB.

Where to Go Next

The next part of the tutorial, “Setting Up a MATLAB® Coder Project” on page
2-17, shows you how to set up a MATLAB Coder project

Setting Up a MATLAB Coder Project

1 From the MATLAB main menu, select File > New > Code Generation
Project.

2 The MATLAB Coder Project dialog box opens.

3 In this dialog box, enter a name for the project, for example, kalman_filter,
and click OK.
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MATLAB Coder creates the project, kalman_filter.prj, in the current

folder and , by default, opens the project in the right side of the MATLAB
workspace.

(= kalman _filter.prj - B -
Che ol ey Build
Entry-Point Files (7]

Add only the file(s) that you would call directly from MATLAB. Do not add files
that are called by these files.

[Add files

Global Variables 7]

If you use global variables in your MATLAE algorithm, add a global type definition
and initial value for each before building the project. If you do not do this, you
must create a variable in the global workspace.

[Add glebal

You are now ready to add the kalman01.m file to your project.
4 On the MATLAB Coder project Overview tab, click Add files.
The Add Files dialog box opens.
5 In the dialog box, select kalman01.m and click Open.

MATLAB Coder adds the file to the project. kalman01 function has one
input parameter, z, which appears below the file name. Note that its type
1s undefined.

6 Because C uses static typing, MATLAB Coder must determine the
properties of all variables in the MATLAB files at compile time. Therefore,
you must specify the properties of all function inputs at the same time as
you compile the file. To compile kalman01.m, you must specify the size of
the input vector z. Here, you define z by example, using data stored in the
file position.mat that you want the Kalman filter algorithm to process.
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a Load the position.mat file into your MATLAB workspace.

load position.mat

This command loads a matrix position containing the x and y
coordinates of 310 points in Cartesian space.

b In the MATLAB Coder project, on the Overview tab, select the input
parameter z and click the Actions icon (#) to the right of z to open the
context menu.

¢ From the context menu, select Define by Example.

The Define by Example dialog box opens.

d In the MATLAB Expression field, enter position(1:2,1) and then
click OK.

MATLAB Coder uses the class, size, and complexity of this expression
to define z.

You are now ready to build the project to generate a MEX function for
kalmanO1.m.

Generating a MEX Function Using MATLAB Coder

1 Click the MATLAB Coder project Build tab.

By default, the project will generate a MEX function named kalmanO1_mex.

Note For the purpose of this tutorial, use the default build settings. To
fine tune the MEX code generation, you can click More settings to open
the Project Settings dialog box and configure build settings.

2 Click the Build button.
The Build progress dialog box appears. When the build is complete,

MATLAB Coder generates a MEX function kalman01_mex in the current
folder.

2-19
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Note The file extension is platform dependent.

You have proved that the Kalman filter example code is suitable for code
generation using MATLAB Coder. You are ready to begin the next task in
this tutorial, “Validating the MEX Function” on page 3-19.

Validating the MEX Function

In this part of the tutorial, you test the MEX function to verify that it provides
the same functionality as the original MATLAB code.

In addition, simulating your algorithm in MATLAB before generating C code
enables you to detect and fix run-time errors that would be much harder to
diagnose in the generated C code. By default, the following run-time checks
execute when you simulate your MEX function in MATLAB:

® Memory integrity checks. These checks perform array bounds and
dimension checking and detect violations of memory integrity in code
generated for MATLAB functions. If a violation is detected, MATLAB stops
execution with a diagnostic message.

® Responsiveness checks in code generated for MATLAB functions. These
checks enable periodic checks for Ctrl+C breaks in code generated for
MATLAB functions, allowing you to terminate execution with Ctrl+C at
any time.

For more information, see “Controlling Run-Time Checks”.

Running the Generated MEX Function

You run the MEX function, kalman01_mex, using the same inputs you used in
“Running the Original MATLAB Code” on page 3-12. You use the test script
test02_ui.m, which calls the MEX function.

At the MATLAB command line, enter:

test02_ui
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Contents of test02 ui.m

% Figure setup
clear all;

load position.mat
numPts = 300;
figure;hold;grid;

% Kalman filter loop

for idx = 1: numPts
% Generate the location data
z = position(:,idx);

% Use Kalman filter to estimate the location
y = kalman01_mex(z);

% Plot the results
plot_trajectory(z,y);
end
hold;

The test script runs and plots the trajectory of the object and the Kalman
filter estimated position as before.

You have generated a MEX function for your MATLAB code, verified that it
is functionally equivalent to your original MATLAB code, and checked that
no run-time errors occur. Now you are ready to begin the next task in this
tutorial, “Generating C Code Using codegen” on page 3-20.

Generating C Code Using MATLAB Coder

In this task, you use MATLAB Coder to generate C code for your MATLAB
filter algorithm. You then view the generated C code using the code generation
report and compare the generated C code with the original MATLAB code.

How to Generate C Code

1 On the Build tab, from the Output type drop-down list, select C/C++
Static Library.

2-21
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MATLAB Coder is now ready to generate a static library for kalman01. The
default name for the library is kalmanoO1.

Note For the purpose of this tutorial, use the default build settings.
Different project settings are available for MEX and C/C++ output types.
When you switch between MEX and C/C++ code generation, you should
check these settings to ensure that they are correct.

2 On the Build tab, click the Build button.

The Build progress dialog box appears. MATLAB Coder generates a
standalone C library kalmanO1 in the work\codegen\lib\kalman01, where
work is the folder that contains your tutorial files, and provides a link to
the code generation report.

3 To view the code generation report, click View report.
The Code Generation Report appears.
4 In the report, click the C code tab to display the list of generated C files.

5 To view the generated C code, click the link to the target source file, for
example, kalmanO1.c.

The file appears in the right pane. The code generation report provides a
hyperlink to open the C code in the MATLAB Editor.

To learn more about the report, see “Code Generation Reports”.

Comparing the Generated C Code to Original MATLAB
Code

To compare your generated C code to the original MATLAB code, open the C
file, kalman01.c, and the kalman01.m file in the MATLAB Editor. View the
files side by side by selecting Window > Left/Right Tile.

Here are some important points about the generated C code:

¢ The function signature is:
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void kalmanO1(const real T z[2], real T y[2])

z corresponds to the input z in your MATLAB code. The size of z is 2, which
corresponds to the total size (2 x 1) of the example input you used when
you compiled your MATLAB code.

® You can easily compare the generated C code to your original MATLAB
code. In the generated C code:

= Your function name is unchanged.
= Your comments are preserved in the same position.

= Your variable names are the same as in the original MATLAB code.

Note If a variable in your MATLAB code is set to a constant value,
it does not appear as a variable in the generated C code. Instead, the
generated C code contains the actual value of the variable.

Modifying the Filter to Accept a Fixed-Size Input

The filter you have worked on so far in this tutorial uses a simple batch
process that accepts one input at a time, so you must call the function
repeatedly for each input. In this part of the tutorial, you learn how to modify
the algorithm to accept a fixed-sized input, which makes the algorithm
suitable for frame-based processing.

Modifying Your MATLAB Code

To modify the code yourself, work through the exercises in this section.
Otherwise, open the supplied file kalman03.m in your solutions subfolder to
see the modified algorithm.

The filter algorithm you have used so far in this tutorial accepts only one
input. You can now modify the algorithm to process a vector containing more
than one input. You need to find the length of the vector and call the filter
code for each element in the vector in turn. You do this by calling the filter
algorithm in a for-loop.

1 Open kalmanO1.m in the MATLAB Editor.
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edit kalmanOi1.m

Tip Before modifying your code, it is best practice to preserve the current
version by backing it up.

2 Add a for-loop around the filter code.

a Before the comment

% Predicted state and covariance
insert:
for i=1:size(z,2)
b After

% Compute the estimated measurements
y = H * x_est;

insert:
end

Your filter code should now look like this:

for i=1:size(z,2)

% Predicted state and covariance
X_prd = A * x_est;

p_prd = A * p est * A" + Q;

timation
§ =H* p_prd" * H' + R;
B=H?*p_prd';
Kk gain = (S \ B)';
% Estimated state and covariance

x_est = x_prd + klm_gain * (z - H * x_prd);
p_est = p_prd - klm_gain * H * p_prd;

2-24
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% Compute the estimated measurements
y = H * x_est;
end

3 Modify the line that calculates the estimated state and covariance to use
the it element of input z.

Change

x_est x_prd + klm_gain * (z - H * x_prd);

to

x_est = x_prd + klm_gain * (z(:,i) - H * x_prd);

4 Modify the line that computes the estimated measurements to append the
result to the it" element of the output y.

Change
y = H * x_est;
to

y(:,i) = H * x_est;

The code analyzer message indicator in the top right turns red to indicate
that the code analyzer has detected an error. The code analyzer underlines
the offending code in red and places a red marker to the right.

5 Move your pointer over the red marker to view the error.

The code analyzer reports that code generation does not support growth
of the variable y through indexing.

Why Preallocate the Outputs?
You must preallocate outputs here because code generation does not support
increasing the size of an array through indexing. Repeatedly expanding

the size of an array over time can adversely affect the performance of your
program. See “Preallocating Memory” in MATLAB Mathematics.
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29
30
31
32
33
34
35
36
37

o
o

39
40
41
42
43
44
45

for

end

i=l:=zize(=z,2)

% Predicted state and covariance
X prd = A * X e3C;

A * pest * A' 4+ O

o
e
H
=3

I

% Estimation
5=H*pprd' * H' + R:
B=H*pprd"';

kElm gain = (3 % B)';

:;maked state and covariance

% E=

% =25t = X prd + kKlm gain * (z(:,1) - H * x prd);

p =25t = p prd - klm gain * H * p prd; =
N @ Line 44: Code generation requires variable 'v' to be fully defined before subscripting it.

¥l & Line 44: Code generation does not support variable 'y size growth through indexing.

L

6 To address the error, preallocate memory for the output y, which is the
same size as the input z. Add this code before the for-loop.

% Pre-allocate output signal:
y=zeros(size(z));

The red error marker disappears and the code analyzer message indicator
in the top right edge of the code turns green, which indicates that you have
fixed all the errors and warnings detected by the code analyzer.

For more information on using the code analyzer, see “Using the MATLAB
Code Analyzer Report” in the MATLAB Desktop Tools and Development
documentation.

7 Save the file.

You are ready to begin the next task in the tutorial, “Testing Your Modified
Algorithm” on page 3-27.
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Testing Your Modified Algorithm

Use the test script test03_ui.m to test the updated kalman01.m. This script
sets the frame size to 10 and calculates the number of frames in the example
input. It then calls the Kalman filter and plots the results for each frame

in turn.

At the MATLAB command line, enter:

test03_ui

The test script runs and plots the trajectory of the object and the Kalman
filter estimated position as before.

You are ready to begin the next task in the tutorial, “Generating C Code for
Your Modified Algorithm” on page 3-27.

Note Before generating C code, it is best practice to generate a MEX function
that you can execute within the MATLAB environment to test your algorithm
and check for run-time errors.

Generating C Code for Your Modified Algorithm

You modified the algorithm to expect fixed-size input, so you must first specify
the input type for the updated kalman01 function.

1 On the MATLAB Coder project Overview tab, select the input parameter
z and click the Actions icon (##) to the right of z to open the context menu.

2 From the context menu, select Define by Example.
The Define by Example dialog box opens.

3 In the MATLAB Expression field, enter position(1:2,1:5) and click
OK.

This expression specifies that the input is a matrix containing five 2x1
position vectors, which corresponds to a frame size of 10.
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MATLAB Coder uses the class, size, and complexity of this expression
to define z.

You are now ready to build the project to generate C code for the updated
file.

To generate C code:

1 On the Build tab, select Generate code only.

This option instructs MATLAB Coder to generate code only without
invoking the make command. If this option is used, MATLAB Coder does
not generate compiled object code. This option saves you time during the
development cycle when you want to iterate rapidly between modifying
MATLAB code and generating C code and are mainly interested in
inspecting the C code.

2 Click the Build button.

The Build progress dialog box appears. MATLAB Coder generates C code
in the work\codegen\lib\kalmanO1, where work is the folder that contains
your tutorial files subfolder and provides a link to the code generation
report.

3 To view the code generation report, click View report

The Code Generation Report appears.
4 Click the C code tab to display the list of generated C files.
5 Click the link to kalmanO1.c.

The file appears in the right pane.

6 Compare the generated C code with the C code for the scalar Kalman
filter. You see that the code is almost identical except that there is a now a
for-loop for the frame processing.

Here are some important points about the generated C code:

¢ The function signature is now:
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void kalmanO1(const real T z[10], real T y[10])

The size of z and y is now 10, which corresponds to the size of the
example input z (2x5) used to compile your MATLAB code.

¢ The filtering now takes place in a for-loop. The for-loop iterates over
all 5 inputs.

for(i = 0; i < 5; i++)
{

/* Predicted state and covariance */

Modifying the Filter to Accept a Variable-Size Input

The algorithm you have used so far in this tutorial is suitable for processing
input data that consists of fixed-size frames. In this part of the tutorial, you
test your algorithm with variable-size inputs and see that the algorithm is
suitable for processing packets of data of varying size. You then learn how to
generate code for a variable-size input.

Testing the Algorithm with Variable-Size Inputs
Use the test script test04 _ui.m to test the filter with variable-size inputs.

The test script calls the filter algorithm in a loop, passing a different size
input to the filter each time. Each time through the loop, the test script calls
the plot_trajectory function for every position in the input.

To run the test script, at the MATLAB command line, enter:

test04_ui

The test script runs and plots the trajectory of the object and the Kalman
filter estimated position as before.

You have successfully created an algorithm that accepts variable-size inputs.

You are ready to begin the next task in the tutorial, “Generating C Code for a
Variable-Size Input” on page 3-29.
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Note Before generating C code, it is best practice to generate a MEX function
that you can execute within the MATLAB environment to test your algorithm
and check for run-time errors.

Generating C Code for a Variable-Size Input
How to Generate C Code for a Variable-Size Input.

1 First, specify the new maximum size for input z. For the purpose of the
tutorial, specify a two-dimensional matrix whose first dimension is 2,
second dimension is 100.

a On the Overview tab, select the input parameter z and click the Actions
icon (#) to the right of z to open the context menu.

b From the context menu, select Define by Example.

The Define by Example dialog box opens.

¢ In the MATLAB Expression field, enter position(1:2,1:100) and
click OK.

MATLAB Coder uses the class, size, and complexity of this expression to
define z, so z is now double (2x100).

2 Now, specify that the second dimension of z is variable size.

a From the context menu, select Edit Type.

The Define Type dialog box opens.
b Click the Actions icon (%) to the right of the Size field to open the menu.

¢ From this menu, select Edit Size Vector Definition.

The Edit Size Vector Definition dialog box opens.

2-30
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4\ MATLAR Coder: Edit Size Vector Definition ==
Define the size of each dimension. For each dimension, select the
Dirnension Category and, if appropriate, specify the Dimension
Bound. If the dimension is unbounded, the Dimension Bound does
not apply.

Dirnension Category Dirnension Bound
Fixed size 100
Help ] ’ OK ] [ Cancel ] ’ + ] ’ =

d Select the Dimension Category column for the second dimension whose
size is 100, then click the = icon that appears to expand the drop-down
menu.

e From this menu, select Variable with specified upper bound and
click OK.
The size of zis now 2 x :100. The : in front of the second dimension
indicates that this dimension is variable size.

f On the Define Type dialog box, click OK.

You are now ready to build the project to generate C code for variable-size
data.

3 On the Build tab, click the Build button.

The Build progress dialog box appears. MATLAB Coder generates a
standalone C library kalmanO1 in the work\codegen\lib\kalmanO1, where
work is the folder that contains your tutorial files. subfolder and provides a
link to the code generation report.
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4 View the generated C code as before.

Here are some important points about the generated C code:

The generated C code can process any size input from 2 x 1to2 x 100.
The function signature is now:

void kalmanO1(real T z_data[200],
int32_T z_sizes[2],
real T y_data[200], int32_T y_sizes[2])

Because y and z are variable size, the generated code contains two pieces
of information about each of them: the data and the actual size of the
sample. For example, for variable z, the generated code contains:

= The data z_data[200], where 200 is the maximum size specified
using coder.typeof.

- z_sizes[2], which contains the actual size of the input data. This
information varies each time the filter is called.

To maximize efficiency, the actual size of the input data z_sizes is used
when calculating the estimated position. This ensures that the filter
processes only the number of samples available in the input.

for(i = 0; i+1 <= z_sizes[1]; i++) {
/* Predicted state and covariance */
for(k = 0; k < 6; k++) {
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Key Points to Remember

¢ Back up your MATLAB code before you modify it.

e Use test scripts to separate the pre- and post-processing from the core
algorithm.

® Generate a MEX function before generating C code. Use this MEX function
to simulate your algorithm in MATLAB to validate its operation and check
for run-time errors.

e Use the Define by Example option to specify input parameters if you have
test data with the correct class, size, and complexity.

® Create a code generation report.
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Learn More

In this section...

“Next Steps” on page 2-34

“Product Help” on page 2-35
“MathWorks Online” on page 2-35

Next Steps

To...

See...

Learn how to integrate your MATLAB code
with Simulink® models

“Tutorial: Integrating MATLAB Code with a
Simulink Model for Tracking a Moving Object”
in the Simulink documentation

Learn more about using MATLAB for code
generation

Code Generation from MATLAB User’s Guide

Use variable-size data

“How Working with Variable-Size Data is
Different for Code Generation” in the Code
Generation from MATLAB documentation.

Speed up fixed-point MATLAB code

fiaccel in the Fixed-Point Toolbox
documentation.

Integrate custom C code into MATLAB code
and generate embeddable code

“Custom C/C++ Code Integration”

Integrate custom C code into a MATLAB
function for code generation

coder.ceval

Generate HDL from MATLAB code

www.mathworks.com/products/slhdlcoder

Learn more about the best practices used in
this tutorial

Chapter 5, “Best Practices for Working with
MATLAB Coder”



http://www.mathworks.com/products/slhdlcoder/

Learn More

Product Help

MathWorks product documentation is available from the Help menu on the
MATLAB desktop.

For... See...

Code Generation from MATLAB Code Generation from MATLAB
User’s Guide

A list of MATLAB and toolbox Code Generation from MATLAB

functions that are suitable for code | Reference

generation

What’s new e MATLAB Coder Release Notes
® Code Generation from MATLAB

Release Notes

MathWorks Online

For additional information and support, visit the MATLAB Coder page on
the MathWorks Web site at:

www .mathworks.com/products/matlab-coder

2-35


http://www.mathworks.com/products/matlab-coder/

2 Tutorial: Generating C Code from MATLAB® Code Using the MATLAB® Coder™ Project Interface

2-36
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Code from MATLAB Code

at the Command Line

¢ “Learning Objectives” on page 3-2

e “Tutorial Prerequisites” on page 3-3

¢ “Example: The Kalman Filter” on page 3-4
¢ “Files for the Tutorial” on page 3-7

¢ “Design Considerations When Writing MATLAB Code for Code Generation”
on page 3-9

e “Tutorial Steps” on page 3-11

¢ “Key Points to Remember” on page 3-32

® “Best Practices Used in This Tutorial” on page 3-33
¢ “Where to Learn More” on page 3-34
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Learning Objectives

In this tutorial, you will learn how to:

Automatically generate a MEX function from your MATLAB code and
use this MEX function to validate your algorithm in MATLAB before
generating C code.

Automatically generate C code from your MATLAB code.
Define function input properties at the command line.
Specify variable-size inputs when generating code.
Specify code generation properties.

Generate a code generation report that you can use to debug your MATLAB
code and verify that it is suitable for code generation.



Tutorial Prerequisites

Tutorial Prerequisites

In this section...
“What You Need to Know” on page 3-3

“Required Products” on page 3-3

What You Need to Know

To complete this tutorial, you should have basic familiarity with MATLAB
software.

Required Products

To complete this tutorial, you must install the following products:

e MATLAB
e MATLAB Coder
¢ C compiler (for most platforms, a default C compiler is supplied with

MATLAB)

For a list of supported compilers, see
http://www.mathworks.com/support/compilers/current_release/.

You must set up the C compiler before generating C code. See “Setting Up
Your C Compiler” on page 3-13.

For instructions on installing MathWorks products, see the MATLAB
installation documentation for your platform. If you have installed MATLAB
and want to check which other MathWorks products are installed, enter ver
in the MATLAB Command Window.
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Example: The Kalman Filter

In this section...

“Description” on page 3-4
“Algorithm” on page 3-4
“Filtering Process” on page 3-5

“Reference” on page 3-6

Description

This section describes the example used by the tutorial. You do not have to be
familiar with the algorithm to complete the tutorial.

The example for this tutorial uses a Kalman filter to estimate the position
of an object moving in a two-dimensional space from a series of noisy inputs
based on past positions. The position vector has two components, x and vy,
indicating its horizontal and vertical coordinates.

Kalman filters have a wide range of applications, including control, signal
and image processing; radar and sonar; and financial modeling. They are
recursive filters that estimate the state of a linear dynamic system from a
series of incomplete or noisy measurements. The Kalman filter algorithm
relies on the state-space representation of filters and uses a set of variables
stored in the state vector to characterize completely the behavior of the
system. It updates the state vector linearly and recursively using a state
transition matrix and a process noise estimate.

Algorithm

This section describes the algorithm of the Kalman filter and is implemented
in the MATLAB version of the filter supplied with this tutorial.

The algorithm predicts the position of a moving object based on its past
positions using a Kalman filter estimator. It estimates the present position
by updating the Kalman state vector, which includes the position (x and y),
velocity (Vx and Vy), and acceleration (Ax and Ay) of the moving object. The
Kalman state vector, x_est, is a persistent variable.



Example: The Kalman Filter

% Initial conditions
persistent x_est p_est
if isempty(x_est)
x_est = zeros(6, 1);
p_est = zeros(6, 6);
end

x_est is initialized to an empty 6x1 column vector and updated each time
the filter is used.

The Kalman filter uses the laws of motion to estimate the new state:

X=X, +Vxdt
Y =Y, +Vy.dt
Vx = Vxy + Ax.dt
Vy =Vyy + Ay.dt

These laws of motion are captured in the state transition matrix A, which is a
matrix that contains the coefficient values of x, y, V,, vy, A, and A,

% Initialize state transition matrix
dt=1;
A=[ 1

o O o oo
[N eNeNel o)

Filtering Process

The filtering process has two phases:

® Predicted state and covariance

The Kalman filter uses the previously estimated state, x_est, to predict the
current state, x_prd. The predicted state and covariance are calculated in:

% Predicted state and covariance

X_prd = A * x_est;
p_prd = A * p_est * A" + Q;
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e Estimation

The filter also uses the current measurement, z, and the predicted state,
Xx_prd, to estimate a more accurate approximation of the current state. The
estimated state and covariance are calculated in:

o°

Measurement matrix
=[100000; 010000 ];
= eye(6);

1000 * eye(2);

T O I
|

o°

Estimation

=H * p_prd" * H' + R;
=H * p_prd';

_gain = (S \ B)';

x W0 »w
[
3

% Estimated state and covariance
x_est = x_prd + klm_gain * (z - H * x_prd);
p_est = p_prd - klm_gain * H * p_prd;

% Compute the estimated measurements
y = H * x_est;

Reference

Haykin, Simon. Adaptive Filter Theory. Upper Saddle River, NJ:
Prentice-Hall, Inc., 1996.
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Files for the Tutorial

In this section...
“About the Tutorial Files” on page 3-7

“Location of Files” on page 3-7

“Names and Descriptions of Files” on page 3-8

About the Tutorial Files

The tutorial uses the following files:

¢ Example MATLAB code files for each step of the tutorial.

Throughout this tutorial, you work with MATLAB files that contain a
simple Kalman filter algorithm.

¢ Build scripts that you use to compile your function code.
e Test files that:

= Perform the preprocessing functions.

= Call the Kalman filter.

= Perform the post-processing functions.

e A MAT-file that contains input data.

Location of Files

The tutorial files are available in the following folder:
docroot\toolbox\coder\examples\kalman. To run the tutorial,

you must copy these files to a local folder. For instructions, see “Copying
Files Locally” on page 3-11.
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Names and Descriptions of Files

Type Name Description
Function | kalmanO1.m Baseline MATLAB implementation of a
code scalar Kalman filter.
kalman02.m Version of the original algorithm that is
suitable for code generation.
kalman03.m Kalman filter suitable for use with
frame-based and packet-based inputs.
Build build01.m Generates MEX function for the original
scripts Kalman filter.
build02.m Generates C code for the original Kalman
filter.
build03.m Generates C code for the frame-based
Kalman filter.
build04.m Generates C code for the variable-size
(packet-based) Kalman filter.
Test test01.m Tests the scalar Kalman filter and plots
scripts the trajectory.
test02.m Tests MEX function for the original
Kalman filter and plots the trajectory.
test03.m Tests the frame-based Kalman filter.
test04.m Tests the variable-size (packet-based)
Kalman filter.
MAT-file | position.mat Contains the input data used by the
algorithm.
Plot plot_trajectory.m Plots the trajectory of the object and the
function Kalman filter estimated position.




Design Considerations When Writing MATLAB® Code for Code Generation

Design Considerations When Writing MATLAB Code for

Code Generation

When writing MATLAB code that you want to convert into efficient,
standalone C/C++ code, you must consider the following:

® Data types

C and C++ use static typing. To determine the types of your variables before
use, MATLAB Coder requires a complete assignment to each variable.

® Array sizing

Variable-size arrays and matrices are supported for code generation. You
can define inputs, outputs, and local variables in MATLAB functions to
represent data that varies in size at run time.

® Memory

You can choose whether the generated code uses static or dynamic memory
allocation.

With dynamic memory allocation, you potentially use less memory at the
expense of time to manage the memory. With static memory, you get best
speed performance, but with higher memory usage. Most MATLAB code
takes advantage of the dynamic sizing features in MATLAB, therefore
dynamic memory allocation typically enables you to generate code from
existing MATLAB code without modifying it much. Dynamic memory
allocation also allows some programs to compile successfully even when
upper bounds cannot be found.

Static allocation reduces the memory footprint of the generated code, and
therefore is suitable for applications where there is a limited amount of
available memory, such as embedded applications.

® Speed

Because embedded applications must run in real time, the code must be
fast enough to meet the required clock rate.

To improve the speed of the generated code:

= Choose a suitable C/C++ compiler. The default compiler that MathWorks
supplies with MATLAB for Windows 32-bit platforms is not a good
compiler for performance.
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= Consider disabling run-time checks.

By default, for safety, the code generated for your MATLAB code contains
memory integrity checks and responsiveness checks. Generally, these
checks result in more generated code and slower simulation. Disabling
run-time checks usually results in streamlined generated code and faster
simulation. Disable these checks only if you are sure that your code is
safe and that array bounds and dimension checking is unnecessary.

See Also
® “About Code Generation from MATLAB Algorithms” in the Code
Generation from MATLAB documentation

® “Defining MATLAB Variables for C/C++ Code Generation” in the Code
Generation from MATLAB documentation

¢ “How Working with Variable-Size Data is Different for Code Generation” in
the Code Generation from MATLAB documentation.

¢ “Bounded Versus Unbounded Variable-Size Data” in the Code Generation
from MATLAB documentation

¢ “Enabling and Disabling Dynamic Memory Allocation”

¢ “Controlling Run-Time Checks”
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Tutorial Steps

In this section...

“Copying Files Locally” on page 3-11

“Running the Original MATLAB Code” on page 3-12

“Setting Up Your C Compiler” on page 3-13

“Making the MATLAB Code Suitable for Code Generation” on page 3-14
“Generating a MEX Function Using codegen” on page 3-18

“Validating the MEX Function” on page 3-19

“Generating C Code Using codegen” on page 3-20

“Comparing the Generated C Code to Original MATLAB Code” on page 3-22
“Modifying the Filter to Accept a Fixed-Size Input” on page 3-23

“Modifying the Filter to Accept a Variable-Size Input” on page 3-29

Copying Files Locally

Copy the tutorial files to a local working folder:

1 Create a local solutions folder, for example, c: \coder\kalman\solutions.

2 Change to the docroot\toolbox\coder\examples folder. At the MATLAB
command line, enter:

cd(fullfile(docroot, 'toolbox', 'coder', 'examples'))

3 Copy the contents of the kalman subfolder to your local solutions folder,
specifying the full path name of the solutions folder:

copyfile('kalman', 'solutions')

Your solutions folder now contains a complete set of solutions for the
tutorial. If you do not want to perform the steps for each task in the
tutorial, you can view the solutions to see how the code should look.

4 Create a local work folder, for example, c:\coder\kalman\work.
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5 Copy the following files from your solutions folder to your work folder.
® kalmanO1.m
® position.mat
® Build files build 01.m through build 04.m
e Test scripts test 01.m through test 04.m
® plot_trajectory.m

Your work folder now contains all the files that you need to get started
with the tutorial.

Running the Original MATLAB Code

In this tutorial, you work with a MATLAB function that implements a Kalman
filter algorithm, which predicts the position of a moving object based on its
past positions. Before generating C code for this algorithm, you make the
MATLAB version suitable for code generation and generate a MEX function.
Then you test the resulting MEX function to validate the functionality of the
modified code. As you work through the tutorial, you refine the design of the
algorithm to accept variable-size inputs.

First, use the script test01.m to run the original MATLAB function to see
how the Kalman filter algorithm works. This script loads the input data and
calls the Kalman filter algorithm to estimate the location. It then calls a
plot function, plot_trajectory, which plots the trajectory of the object and
the Kalman filter estimated position.

1 Set your MATLAB current folder to the work folder that contains your files
for this tutorial. At the MATLAB command line, enter:

cd work

where work is the full path name of the work folder containing your files.
For more information, see “Using the Current Folder Browser” in the
MATLAB Desktop Tools and Development Environment documentation.

2 At the MATLAB command line, enter:

testO1
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short time for the estimated position to converge with the actual position
of the object. Then three sudden shifts in position occur—each time the

Kalman filter estimated position in green. Initially, you see that it takes a
Kalman filter readjusts and tracks the object after a few iterations.

The test script runs and plots the trajectory of the object in blue and the

Trajectory of object [blue] its Kalman estimate[green]
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compiler, for a list of supported compilers for the current release of MATLAB,

Before using codegen to compile the Kalman filter example code, you must
set up your C compiler. For most platforms, MathWorks supplies a default

compiler with MATLAB. If your installation does not include a default

Setting Up Your C Compiler
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see http://www.mathworks.com/support/compilers/current_release/ and install
a compiler that is suitable for your platform.

To set up the installed compiler:

1 At the MATLAB command line, enter:

mex -setup

2 Enter y to see the list of installed compilers.
3 Select a supported compiler.

4 Enter y to verify your choice.

Making the MATLAB Code Suitable for Code
Generation

® “Considerations for Making Your Code Suitable for Code Generation” on
page 3-14

¢ “Where to Go Next” on page 3-16
¢ “Making Your Code Suitable for Code Generation” on page 3-16

Considerations for Making Your Code Suitable for Code
Generation

Designing for Code Generation. Before generating code, you must
prepare your MATLAB code for code generation. The first step is to eliminate
unsupported constructs.

Checking for Violations at Design Time. You use the code analyzer in
the MATLAB Editor to check for code violations at design time, minimizing
compilation errors. The code analyzer continuously checks your code as you
enter it. It reports problems and recommends modifications to maximize
performance and maintainability.

To use the code analyzer to identify warnings and errors specific to MATLAB
for code generation, you must add the %#codegen directive (or pragma) to your
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MATLAB file. A complete list of MATLAB for Code Generation code analyzer
messages 1s available in the MATLAB Code Analyzer preferences. See “Using
the MATLAB Code Analyzer Report” for more details.

Note The code analyzer might not detect all MATLAB for code generation
issues. After eliminating any errors or warnings that the code analyzer
detects, compile your code with codegen to determine if the code has other
compliance issues.

Checking for Violations at Code Generation Time. You can use
codegen to check for violations at code generation time. codegen checks that
your MATLAB code is suitable for code generation, as described in “About
Code Generation from MATLAB Algorithms” in the Code Generation from
MATLAB documentation.

When codegen detects errors or warnings, it automatically generates an error
report that describes the issues and provides links to the offending MATLAB
code. For more information, see “Code Generation Reports” .

After successful code generation, codegen generates a MEX function that you
can use to test your implementation in MATLAB.

Checking for Violations at Run Time. You can use codegen to generate
a MEX function and check for violations at run time. In simulation, the
code generated for your MATLAB functions includes the run-time checks.
Disabling run-time checks and extrinsic calls usually results in streamlined
generated code and faster simulation. You control run-time checks using the
MEX configuration object, coder.MexCodeConfig. For more information,
see “Controlling Run-Time Checks”.

If you encounter run-time errors in your MATLAB functions, a run-time stack

appears automatically in the MATLAB Command Window. See “Debugging
Run-Time Errors”.
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Where to Go Next

The next section of the tutorial, “Making Your Code Suitable for Code
Generation” on page 3-16, shows you how to use the MATLAB code analyzer
and codegen to ensure that your MATLAB code is suitable for code generation.

Making Your Code Suitable for Code Generation

To modify the code yourself, work through the exercises in this section.
Otherwise, open the supplied file kalman02.m in your solutions subfolder to
see the modified algorithm.

To begin the process of making your MATLAB code suitable for code
generation, you work with the file kalman01.m. This code is a MATLAB
version of a scalar Kalman filter that estimates the state of a dynamic system
from a series of noisy measurements.

1 Set your MATLAB current folder to the work folder that contains your files
for this tutorial. At the MATLAB command line, enter:

cd work

where work is the full path name of the work folder containing your files.
See “Using the Current Folder Browser” in the MATLAB Desktop Tools
and Development Environment documentation for more information.

2 Open kalmanO1.min the MATLAB Editor. At the MATLAB command
line, enter:

edit kalmanOi1.m

The file opens in the MATLAB Editor. The code analyzer message indicator
in the top right corner of the MATLAB Editor is green, which indicates that
it has not detected any errors, warnings, or opportunities for improvement
in the code.

3 Turn on MATLAB for code generation error checking by adding the
%#codegen directive after the function declaration.

function y = kalmanO1(z) S%#codegen
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The code analyzer message indicator remains green, indicating that it has
not detected any code generation related issues.

i - -
function ¥ = kalmanil (z) FFcodegen -
% Initialize state transition matrix
de=1;
A=[ 1 0dc © 0 O;... =
010 de 0 Or...
001 0dc Or...
00010 de:...
000010 ;...
00O0O0O01]:

For more information on using the code analyzer, see “Using the MATLAB
Code Analyzer Report” in the MATLAB Desktop Tools and Development
documentation.

4 Save the file in the current folder as kalman02.m:

a To match the function name to the file name, change the function name
to kalmanoO2.

function y = kalman02(z)

b In the MATLAB Editor, select Save As from the File menu.

¢ Enter kalman02.m as the new file name.

Note If you do not match the file name to the function name, the code
analyzer warns you that these names are not the same and highlights
the function name in orange to indicate that it can provide an automatic
correction. For more information, see “Changing Code Based on Code
Analyzer Messages” in the MATLAB documentation.

d Click Save.

You are now ready to compile your code using codegen. By default,
codegen checks that your MATLAB code is suitable for code generation, as
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described in “About Code Generation from MATLAB Algorithms”. Then,
after successful compilation, codegen generates a MEX function that you
can test in MATLAB.

Generating a MEX Function Using codegen

Because C uses static typing, codegen must determine the properties of all

variables in the MATLAB files at compile time. Therefore, you must specify
the properties of all function inputs at the same time as you compile the file
with codegen.

To compile kalman02.m, you must specify the size of the input vector y.

1 Load the position.mat file into your MATLAB workspace.

load position.mat

This command loads a matrix position containing the x and y coordinates
of 310 points in Cartesian space.

2 Get the first vector in the position matrix.

z = position(1:2,1);

3 Compile the file kalman02.m using codegen.

codegen -report kalman02.m -args {z}

codegen reports that the code generation was successful. By default,
it generates a MEX function, kalman02_mex, in the current folder and
provides a link to the code generation report.

Note that:

® The -report option instructs codegen to generate a code generation
report, which you can use to debug your MATLAB code and verify that
it is suitable for code generation.

¢ The -args option instructs codegen to compile the file kalman02.m using
the class, size, and complexity of the sample input parameter z.
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You have proved that the Kalman filter example code is suitable for code
generation using codegen. You are ready to begin the next task in this
tutorial, “Validating the MEX Function” on page 3-19.

Validating the MEX Function

In this part of the tutorial, you test the MEX function to verify that it provides
the same functionality as the original MATLAB code.

In addition, simulating your algorithm in MATLAB before generating C code
enables you to detect and fix run-time errors that would be much harder to
diagnose in the generated C code. By default, the following run-time checks
execute when you simulate your MEX function in MATLAB:

® Memory integrity checks. These checks perform array bounds and
dimension checking and detect violations of memory integrity in code
generated for MATLAB functions. If a violation is detected, MATLAB stops
execution with a diagnostic message.

® Responsiveness checks in code generated for MATLAB functions. These
checks enable periodic checks for Ctrl+C breaks in code generated for
MATLAB functions, allowing you to terminate execution with Ctrl+C at
any time.

For more information, see “Controlling Run-Time Checks”.

Running the Generated MEX Function

You run the MEX function, kalman02_mex, using the same inputs you used in
“Running the Original MATLAB Code” on page 3-12. You use the test script
test02.m, which calls the MEX function.

At the MATLAB command line, enter:
test02

Contents of test02.m
% Figure setup

clear all;
load position.mat
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numPts = 300;
figure;hold;grid;

% Kalman filter loop
for idx = 1: numPts

% Generate the location data
= position(:,idx);

N

Use Kalman filter to estimate the location
= kalman02_mex(z);

o°

<

s Plot the results
plot_trajectory(z,y);

°

end
hold;

The test script runs and plots the trajectory of the object and the Kalman
filter estimated position as before.

You have generated a MEX function for your MATLAB code, verified that it
is functionally equivalent to your original MATLAB code, and checked that
no run-time errors occur. Now you are ready to begin the next task in this
tutorial, “Generating C Code Using codegen” on page 3-20.

Generating C Code Using codegen

In this task, you use codegen to generate C code for your MATLAB filter
algorithm. You then view the generated C code using the MATLAB Coder
code generation report and compare the generated C code with the original
MATLAB code. You use the supplied build script build02.m to generate code.

About the Build Script

A build script automates a series of MATLAB commands that you want to
perform repeatedly from the command line, saving you time and eliminating
input errors.

The build script build02.m contains:

% Load the position vector
load position.mat
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o°

Get the first vector in the position matrix

to use as an example input

= position(1:2,1);

Generate C code only, create a code generation report

codegen -c -d buildO02 -config coder.config('lib') -report kalmanO2.m -ar

o°

N

o°

Note that:

e codegen opens the file kalman02.m and automatically translates the
MATLAB code into C source code.
For more information, see “Generating C/C++ Code from MATLAB Code”.

® The -c option instructs codegen to generate code only, without compiling
the code to an object file. This option enables you to iterate rapidly between
modifying MATLAB code and generating C code.

® The -config coder.config('lib') option instructs codegen to generate
embeddable C code suitable for targeting a static library instead
of generating the default MEX function. For more information, see
coder.config.

® The -d option instructs codegen to generate code in the output folder
buildo2.

® The -report option instructs codegen to generate a code generation report
that you can use to debug your MATLAB code and verify that it is suitable
for code generation.

® The -args option instructs codegen to compile the file kalman01.m using
the class, size, and complexity of the sample input parameter z.

How to Generate C Code

1 Run the build script.

build02

MATLAB processes the build file and outputs the message:

Code generation successful: View report.

codegen generates files in the folder, build02.
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S:\Adoc\matlab\doc\src\toolbox\coder\gs\examplesi\kalman'kalman02.m

2 To view the code generation report, click View report.

The MATLAB Coder Code Generation Report appears.

3 Click the C code tab to display the list of generated C files.

4 To view the generated C code, click the link to the target source file, for

example, kalman02.c.

The file appears in the right pane. The code generation report provides a
hyperlink to open the C code in the MATLAB Editor.

To learn more about the report, see “Code Generation Reports”.

Comparing the Generated C Code to Original MATLAB

Code

To compare your generated C code to the original MATLAB code, open the C
file, kalman02.c, and the kalman02.m file in the MATLAB Editor. View the

files side by side by selecting Window > Left/Right Tile.

B function ¥ = kalman02(z) %#cod n ~ 26
9 % itialize state transition matrix 27
10 — dt=1; 28
11 — B=[ 1 0dc 00 0;... 29
12 010dt0O:;... 30
13 0010dc 0;... 31
14 00010dt:... 32
15 000010 ;... 33
16 000001 ]: £ 34
17 35
18 % Measurement matrix 36
alllfes H=[100000; 0100001 37
20 = Q = eve(d); 38
21 - R = 1000 * eye(2): 39
22 40
23 % Initial conditions 41
24 — persistent x_sst p_est 42
25 = if isempty(x_est) 43
26 — x_=st = zeros(6, 1); 44
27 = p_=st = zeros (6, &); 45
28 — end 46
29 - 47

Fl

vold kalman02 (const real T z[2], real T y[2])

{

int32_T r2;
int8 T Q[36];
int32 T rl;
real T x prd[&];

grtatic intd_T iv0[36] = {
9 1,0 1, 0, 0, 0, 0O,

real T klm_gain[36];
int32_T k:
real T a2l;

static int8 T ivl[36] = {
o, 0o, 0, 1, 0, 1, 0, O,

real T p prd[36]:

real T b_klm gain[12];

static int8 T iv2[12]
static int8 T iv3i[l2]

static intlé T ivi[4]

[T

{

{

{

i, 0,

i, o,
o, 0,

Q,
1,

i,
1,

a,
a,

a,
a,

a,
a,

a,
a,

a,
a,

a,
a,

O 2 X  Sh\Adocimatlab\docisrc\toolbox\codergshexamples\kalman'build02\kalman02.c
|

Q,
Q,

Q,
Q,

1,
1,

i,
a,

1,

a,
a,

a,
a,

0,

m

o, 1,

o, 0,
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Here are some important points about the generated C code:

¢ The function signature is:
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void kalmanO2(const real T z[2], real T y[2])

z corresponds to the input z in your MATLAB code. The size of z is 2, which
corresponds to the total size (2 x 1) of the example input you used when
you compiled your MATLAB code.

® You can easily compare the generated C code to your original MATLAB
code. In the generated C code:

= Your function name is unchanged.
= Your comments are preserved in the same position.

= Your variable names are the same as in the original MATLAB code.

Note If a variable in your MATLAB code is set to a constant value,
it does not appear as a variable in the generated C code. Instead, the
generated C code contains the actual value of the variable.

Modifying the Filter to Accept a Fixed-Size Input

The filter you have worked on so far in this tutorial uses a simple batch
process that accepts one input at a time, so you must call the function
repeatedly for each input. In this part of the tutorial, you learn how to modify
the algorithm to accept a fixed-sized input, which makes the algorithm
suitable for frame-based processing.

Modifying Your MATLAB Code

To modify the code yourself, work through the exercises in this section.
Otherwise, open the supplied file kalman03.m in your solutions subfolder to
see the modified algorithm.

The filter algorithm you have used so far in this tutorial accepts only one
input. You can now modify the algorithm to process a vector containing more
than one input. You need to find the length of the vector and call the filter
code for each element in the vector in turn. You do this by calling the filter
algorithm in a for-loop.

1 Open kalman02.m in the MATLAB Editor.
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edit kalman02.m

2 Add a for-loop around the filter code.
a Before the comment
% Predicted state and covariance
insert:
for i=1:size(z,2)
b After

% Compute the estimated measurements
y = H * x_est;

insert:
end
Your filter code should now look like this:

for i=1:size(z,2)

% Predicted state and covariance
x_prd = A * x_est;

p_prd = A * p_est * A' + Q;

% Estimation

S =H™* p_prd" * H' + R;
B=H?*pprd';

klm_gain = (S \ B)';

% Estimated state and covariance
x_est = x_prd + klm_gain * (z - H * x_prd);
p_est = p_prd - klm_gain * H * p_prd;

% Compute the estimated measurements
y = H * x_est;
end

3 Modify the line that calculates the estimated state and covariance to use
the it" element of input z.
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Change
x_est = x_prd + klm_gain * (z - H * x_prd);
to
x_est = x_prd + klm_gain * (z(:,i) - H * x_prd);

Modify the line that computes the estimated measurements to append the
result to the it" element of the output y.

Change

y = H * x_est;

to
y(:,1) = H * x_est;

The code analyzer message indicator in the top right turns red to indicate
that the code analyzer has detected an error. The code analyzer underlines
the offending code in red and places a red marker to the right.

Move your pointer over the red marker to view the error.

The code analyzer reports that code generation does not support growth
of the variable y through indexing.

Why Preallocate the Outputs?

You must preallocate outputs here because the MATLAB for code
generation does not support increasing the size of an array over time.
Repeatedly expanding the size of an array over time can adversely affect
the performance of your program. See “Preallocating Memory” in MATLAB
Mathematics.
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29
30
31
32
33
34
35
36
37

o
o

39
40
41
42
43
44
45

for i=l:=zize(=z,2)

% Predicted state and covariance

X prd = A * X e3C;

pprd =& % p est * A" + 7
% Estimation

5=H * p prd*' * H" + R;

B =

:;maked state and covariance

=
=t = ®x prd + kKlm gain * (z(:,1) - H * x prd):
st = p prd - klm gain * H # p prd; =

_ @ Line 44: Code generation requires variable 'v' to be fully defined before subscripting it.

& Line 44: Code generation does not support variable 'y size growth through indexing.

L

6 To address the error, preallocate memory for the output y, which is the
same size as the input z. Add this code before the for-loop.

% Pre-allocate output signal:
y=zeros(size(z));

The red error marker disappears and the code analyzer message indicator
in the top right edge of the code turns green, which indicates that you have
fixed all the errors and warnings detected by the code analyzer.

For more information on using the code analyzer, see “Using the MATLAB
Code Analyzer Report” in the MATLAB Desktop Tools and Development
documentation.

7 Change the function name to kalman03 and save the file as kalman03.m
in the current folder.

You are ready to begin the next task in the tutorial, “Testing Your Modified
Algorithm” on page 3-27.
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Testing Your Modified Algorithm

Use the test script test03.m to test kalman03.m. This script sets the frame
size to 10 and calculates the number of frames in the example input. It then
calls the Kalman filter and plots the results for each frame in turn.

At the MATLAB command line, enter:

test03

The test script runs and plots the trajectory of the object and the Kalman
filter estimated position as before.

You are ready to begin the next task in the tutorial, “Generating C Code for
Your Modified Algorithm” on page 3-27.

Note Before generating C code, it is best practice to generate a MEX function
that you can execute within the MATLAB environment to test your algorithm
and check for run-time errors.

Generating C Code for Your Modified Algorithm

You use the supplied build script build03.m to generate code. The only
difference between this build script and the script for the initial version of the
filter is the example input used when compiling the file. build03.m specifies
that the input to the function is a matrix containing five 2x1 position vectors,
which corresponds to a frame size of 10.

Contents of build03.m

% Load the position vector

load position.mat

Get the first 5 positions in the position matrix to use

as an example input

= position(1:2,1:5);

Generate C code only, create a code generation report

codegen -c -config coder.config('lib') -report kalman03.m -args {z}

o°

® N o°

To generate C code for kalman03:
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1 At the MATLAB command line, enter:

build03

MATLAB processes the build file and outputs the message:

Code generation successful: View report.

The generated C code is in work\codegen\1lib\kalman03, where work is
the folder that contains your tutorial files.

2 To view the generated C code:

a Click View report.

The MATLAB Coder Code Generation Report appears.
b Click the C code tab to display the list of generated C files.
¢ Click the link to kalman03.c.

The file appears in the right pane.

3 Compare the generated C code with the C code for the scalar Kalman
filter. You see that the code is almost identical except that there is a now a
for-loop for the frame processing.

Here are some important points about the generated C code:

¢ The function signature is now:

void kalmanO03(const real T z[10], real T y[10])

The size of z and y is now 10, which corresponds to the size of the
example input z (2x5) used to compile your MATLAB code.

¢ The filtering now takes place in a for-loop. The for-loop iterates over
all 5 inputs.

for(i = 0; i < 5; i++)

{

/* Predicted state and covariance */

3-28



Tutorial Steps

Modifying the Filter to Accept a Variable-Size Input

The algorithm you have used so far in this tutorial is suitable for processing
input data that consists of fixed-size frames. In this part of the tutorial, you
test your algorithm with variable-size inputs and see that the algorithm is
suitable for processing packets of data of varying size. You then learn how to
generate code for a variable-size input.

Testing the Algorithm with Variable-Size Inputs
Use the test script test04.m to test kalman03.m with variable-size inputs.

The test script calls the filter algorithm in a loop, passing a different size
input to the filter each time. Each time through the loop, the test script calls
the plot_trajectory function for every position in the input.

To run the test script, at the MATLAB command line, enter:
test04

The test script runs and plots the trajectory of the object and the Kalman
filter estimated position as before.

You have successfully created an algorithm that accepts variable-size inputs.
You are ready to begin the next task in the tutorial, “Generating C Code for a
Variable-Size Input” on page 3-29.

Note Before generating C code, it is best practice to generate a MEX function
that you can execute within the MATLAB environment to test your algorithm
and check for run-time errors.

Generating € Code for a Variable-Size Input
You use the supplied build script build04.m to generate code.

About the Build Script.

Contents of build04.m

% Load the position vector
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load position.mat

N=100;

% Get the first N vectors in the position matrix to

% use as an example input

z = position(1:2,1:N);

% Specify the upper bounds of the variable-size input z

% using the coder.typeof declaration - the upper bound

% for the first dimension is 2; the upper bound for

% the second dimension is N. The first dimension is fixed,
% the second is variable.

eg_z = coder.typeof(z, [2 N], [0 1]);

% Generate C code only

% specify upper bounds for variable-size input z

codegen -c -config coder.config('lib') -report kalman03.m -args {eg_z}

This build file:

® Specifies the upper bounds explicitly for the variable-size input using the
declaration coder.typeof(z, [2 N], [0 1]) with the -args option on
the codegen command line. The second input, [2 N], specifies the size and
upper bounds of the variable size input z. Because N=100, coder.typeof
specifies that the input to the function is a matrix with two dimensions, the
upper bound for the first dimension is 2; the upper bound for the second
dimension is 100. The third input specifies which dimensions are variable.
A value of true or one means that the corresponding dimension is variable;
a value of false or zero means that the corresponding dimension is fixed.
The value [0 1] specifies that the first dimension is fixed, the second
dimension is variable. For more information, see “How to Generate Code
for MATLAB Functions with Variable-Size Data” in the Code Generation
from MATLAB documentation.

® (Creates a code configuration object cfg and uses it with the -config
option to specify code generation parameters. For more information, see
coder.config.

How to Generate C Code for a Variable-Size Input.

1 Use the build script build04 to generate C code.

build04
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2 View the generated C code as before.

Here are some important points about the generated C code:

® The generated C code can process any size input from 2 x 1to2 x 100.
The function signature is now:

void kalmanO3(real T z_data[200],
int32_T z_sizes[2],
real T y_data[200], int32_T y_sizes[2])

Because y and z are variable size, the generated code contains two pieces
of information about each of them: the data and the actual size of the
sample. For example, for variable z, the generated code contains:

= The data z_data[200], where 200 is the maximum size specified
using coder.typeof.

- z_sizes[2], which contains the actual size of the input data. This
information varies each time the filter is called.

¢ To maximize efficiency, the actual size of the input data z_sizes is used
when calculating the estimated position. This ensures that the filter
processes only the number of samples available in the input.

for(i = 0; i+1 <= z_sizes[1]; i++) {

/* Predicted state and covariance */
for(k = 0; k < 6; k++) {
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Key Points to Remember

Back up your MATLAB code before you modify it.

Decide on a naming convention for your files and save interim versions
frequently. For example, this tutorial uses a two-digit suffix to differentiate
the various versions of the filter algorithm.

Use build scripts to build your files.

Use test scripts to separate the pre- and post-processing from the core
algorithm.

Generate a MEX function before generating C code. Use this MEX function
to simulate your algorithm in MATLAB to validate its operation and check
for run-time errors.

Use the -args option to specify input parameters at the command line.
Use the -report option to create a code generation report.
Use coder.typeof to specify variable-size inputs.

Use the code generation configuration object (coder.config) to specify
parameters for standalone C code generation.
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Best Practices Used in This Tutorial

To see the complete list of best practices for using the MATLAB Coder, see
Chapter 5, “Best Practices for Working with MATLAB Coder”.

Best Practice — Preserving Your Code

Preserve your code before making further modifications. This practice
provides a fallback in case of error and a baseline for testing and validation.
Use a consistent file naming convention. For example, add a two-digit suffix
to the file name for each file in a sequence.

Best Practice — Comparing Files

Use the MATLAB Compare Against option to compare two MATLAB files to
examine differences between files.

Best Practice — Generating a Code Generation Report

Use the -report option to generate an HTML report with links to your
MATLAB code files and compile-time type information for the variables and
expressions in your code. This information simplifies finding sources of error
messages and aids understanding of type propagation rules. If you do not
specify this option, codegen generates a report only if errors or warnings
occur. For more information, see .

Best Practice — Using Build Scripts

A build script automates a series of MATLAB commands that you want to
perform repeatedly from the command line, saving you time and eliminating
input errors. For more information, see .

Best Practice — Separating Your Test Bench from Your Function Code
Separate your core algorithm from your test bench. Create a separate test

script to do all the pre- and post-processing such as loading inputs, setting up
input values, calling the function under test, and outputting test results.
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Where to Learn More

In this section...

“Next Steps” on page 3-34
“Product Help” on page 3-35
“MathWorks Online” on page 3-35

Next Steps

TO...

See...

See all the compilation options for codegen

codegen

Learn how to integrate your MATLAB code
with Simulink models

“Tutorial: Integrating MATLAB Code with a
Simulink Model for Tracking a Moving Object”
in the Simulink documentation

Learn more about using MATLAB for code
generation

Code Generation from MATLAB User’s Guide

Use variable-size data

“How Working with Variable-Size Data is
Different for Code Generation” in the Code
Generation from MATLAB documentation.

Speed up fixed-point MATLAB code

fiaccel in the Fixed-Point Toolbox
documentation.

Integrate custom C code into MATLAB code
and generate standalone code

“Custom C/C++ Code Integration”

Integrate custom C code into a MATLAB
function for code generation

coder.ceval in the Code Generation from
MATLAB documentation.

Generate HDL from MATLAB code

www.mathworks.com/products/slhdlcoder

Learn more about the best practices used in
this tutorial

Chapter 5, “Best Practices for Working with
MATLAB Coder”



http://www.mathworks.com/products/slhdlcoder/

Where to Learn More

Product Help

MathWorks product documentation is available from the Help menu on the
MATLAB desktop.

For... See...

Code Generation from MATLAB Code Generation from MATLAB
User’s Guide

A list of MATLAB and toolbox Code Generation from MATLAB

functions that are suitable for code | Reference

generation

What’s new e MATLAB Coder Release Notes
® Code Generation from MATLAB

Release Notes

MathWorks Online

For additional information and support, visit the MATLAB Coder page on
the MathWorks Web site at:

www .mathworks.com/products/matlab-coder
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Tutorial: Generating MEX
Functions from MATLAB
Code at the Command Line

¢ “Learning Objectives” on page 4-2

e “Tutorial Prerequisites” on page 4-3

¢ “Example: Euclidean Minimum Distance” on page 4-4
¢ “Files for the Tutorial” on page 4-6

e “Tutorial Steps” on page 4-9

¢ “Key Points to Remember” on page 4-28

® “Best Practices Used in This Tutorial” on page 4-29

® “Where to Learn More” on page 4-30
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Learning Objectives

In this tutorial, you will learn how to:

e Automatically generate a MEX function from your MATLAB code.

Define function input properties at the command line.

Specify the upper bounds of variable-size data.

Specify variable-size inputs.

Generate a code generation report that you can use to debug your MATLAB
code and verify that it is suitable for code generation.



Tutorial Prerequisites

Tutorial Prerequisites

In this section...
“What You Need to Know” on page 4-3

“Required Products” on page 4-3

What You Need to Know

To complete this part of the tutorial, you should have basic familiarity with
MATLAB software. You do not need to be familiar with or use Simulink or
Fixed-Point Toolbox software.

Required Products

To complete this tutorial, you must install the following products:

e MATLAB
e MATLAB Coder
¢ C compiler

For a list of supported compilers, see
http://www.mathworks.com/support/compilers/current_release/.

You must set up the C compiler before generating C code. See “Setting Up
Your C Compiler” on page 4-13.

For instructions on installing MathWorks products, refer to the installation
documentation. If you have installed MATLAB and want to check which other
MathWorks products are installed, enter ver in the MATLAB Command
Window.
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Example: Euclidean Minimum Distance

In this section...

“Description” on page 4-4

“Algorithm” on page 4-5

Description
The Euclidean distance between points p and ¢ is the length of the line

segment pq. In Cartesian coordinates, if p = (P15 P2, Pp) and ¢ =(q1,92, . qy)
are two points in Euclidean n-space, then the distance from p to q is given by:

d(p,9)=|p-4d|

= \/(Pl ~q1)? +(py —q0)* +.t (P — )

:1/2(131' -q)?
i=1

In one dimension, the distance between two points, xI and x2, on a line is
simply the absolute value of the difference between the two points:

Vg = x1)% =[xy — |

In two dimensions, the distance between p=(p;,py) and g =(gq,q9) is:

\/(pl ~q)% +(py — o)

The example for this tutorial computes the minimum Euclidean distance
between a column vector x and a collection of column vectors in the codebook
matrix cb. The function has three output variables:

¢ y, the vector in ¢b with the minimum distance to x

® jdx, the index of the column vector in ¢b corresponding to the closest vector

® distance, the distance between x and y



Example: Euclidean Minimum Distance

Algorithm

This algorithm computes the minimum Euclidean distance between a column
vector x and a collection of column vectors in the codebook matrix cb. The
algorithm computes the minimum distance to x and finds the column vector in
cb that is closest to x. It outputs this column vector, y, its index, idx, in cb,
and distance, the distance between x and y.

The function signature for the algorithm is:

function [y,idx,distance] = euclidean(x,chb)

The minimum distance is initially set to the first element of cb.

idx=1;
distance=norm(x-cb(:,1));

The minimum distance calculation is performed in the for-loop.

for index=2:size(cb,2)
d=norm(x-cb(:,index));
if d < distance
distance=d;
idx=index;
end
end

The output y is set to the minimum distance vector.

y=cb(:,idx);
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Files for the Tutorial

In this section...

“About the Tutorial Files” on page 4-6

“Location of Files” on page 4-6

“Names and Descriptions of Files” on page 4-7

About the Tutorial Files

The tutorial uses the following files:

¢ Example MATLAB code files for each step of the tutorial.

Throughout this tutorial, you work with MATLAB files that contain a
simple Euclidean distance algorithm.

¢ Build scripts that you use to compile your function code.

e Test files that:
= Perform the preprocessing functions, for example, setting up input data.
= (Call the specified Euclidean function.

= Perform the post-processing functions, for example, plotting the
distances.

e A MAT-file that contains example input data.

Location of Files

The tutorial files are available in the following folder:
docroot\toolbox\coder\gs\examples\euclidean. To run the
tutorial, you must copy these files to a local folder. For instructions, see
“Copying Files Locally” on page 4-9.



Files for the Tutorial

Names and Descriptions of Files

Type Name Description
Function | euclidean01.m Baseline MATLAB implementation of
code Euclidean minimum distance algorithm
including plot functions.
euclidean02.m Version of the original algorithm suitable for
code generation with extrinsic calls to plot
function.
euclidean03.m Version of the original algorithm without
plot function.
euclidean04.m Modified algorithm that uses assert to
specify the upper bounds of variable N.
Build buildO1.m Build script for euclidean03.m.
SEHES build02.m Build script for euclidean03.m specifying
two-dimensional inputs.
build03.m Build script for euclidean03.m specifying
variable-size inputs.
build04.m Build script for euclidean04.m.
Test test01.m Initial version of test script, includes plot
script functions. Tests euclidean03 MEX function.
test02.m Tests the three-dimensional euclidean03

MEX function with two-dimensional inputs.

test03.m Tests the two-dimensional euclidean04
MEX function with two-dimensional inputs.

test04.m Tests euclidean03_varsize MEX function
with two-dimensional and three-dimensional
inputs.

test05.m Tests euclidean04 MEX function specifying

how many elements of each input to process.
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Type

Name

Description

MAT-file

euclidean.mat

Contains the input data used by the
algorithm.




Tutorial Steps

Tutorial Steps

In this section...

“Copying Files Locally” on page 4-9

“Running the Original MATLAB Code” on page 4-10

“Setting Up Your C Compiler” on page 4-13

“Making the MATLAB Code Suitable for Code Generation” on page 4-13
“Generating a MEX Function Using codegen” on page 4-16

“Validating the MEX Function” on page 4-18

“Using Build and Test Scripts” on page 4-19

“Elaborating the Algorithm to Accept Variable-Size Inputs” on page 4-22
“Specifying Upper Bounds for Local Variables” on page 4-26

Copying Files Locally

Copy the tutorial files to a local solutions folder and create a local working
folder:

1 Create a local solutions folder, for example,
c:\coder\euclidean\solutions.

2 Change to the docroot\toolbox\coder\gs\examples folder. At the
MATLAB command line, enter:

cd(fullfile(docroot, 'toolbox', 'coder', 'examples'))

3 Copy the contents of the euclidean subfolder to your local solutions
folder, specifying the full pathname of the solutions folder:

copyfile('euclidean', 'solutions')

Your solutions folder now contains a complete set of solutions for the
tutorial. If you do not want to perform the steps for each task in the
tutorial, you can view the solutions to see how the code should look.

4 Create a local work folder, for example, c¢:\coder\euclidean\work.
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5 Copy the following files from your solutions folder to your work folder.
® ecuclideanO01.m
® euclidean.mat

Build files build01.m through build04.m

e Test scripts test01.m through test05.m

Your work folder now contains all the files that you need to get started
with the tutorial.

Running the Original MATLAB Code

In this tutorial, you work with a MATLAB function that implements the
Euclidean distance minimizing algorithm. You make the MATLAB version
of this algorithm suitable for code generation and test the resulting MEX
function to validate the functionality of the modified code. As you work
through the tutorial, you refine the design of the algorithm to accept
variable-size inputs.

Before generating a MEX function, run the original MATLAB function to see
how the Euclidean distance minimizing algorithm works.

1 Set your MATLAB current folder to the work folder that contains your
files for this tutorial.

cd work

work is the full path name of the work folder containing your files. For
more information, see “Using the Current Folder Browser” in the MATLAB
Desktop Tools and Development Environment documentation.

2 Load the euclidean.mat file into your MATLAB workspace.

load euclidean.mat

Your MATLAB workspace now contains:
® A matrix X containing 40000 three-dimensional vectors.

® A matrix cb containing 216 three-dimensional vectors.

4-10



Tutorial Steps

The Euclidean algorithm minimizes the distance between a column vector,
x1, taken from matrix x, and the column vectors in the codebook matrix cb.
It outputs the column vector in cb that is closest to x1.

3 Create a single input vector x1 from the matrix x.
X1=x(:,1)
The result is the first vector from x:
X1 =
0.8568

0.7455
0.3835

4 Use the Euclidean algorithm to find the vector in codebook matrix cb that
1s closest to x1. At the MATLAB command line, enter:

[y, idx, distance]=euclidean01(x1,cb)

The Euclidean algorithm runs and plots the lines from x1 to each vector
in cb.
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After completing the algorithm, it outputs the coordinates of the point vy,
which is the vector in cb closest to x1, together with the index idx of x1 in
cb, and the distance, distance, between y and x1.

y =
0.8000
0.8000
0.4000
idx =
171
distance =
0.0804

The algorithm computes that the point y=0.8000, 0.8000, 0.4000, the
171t vector in cb, is closest to point x1. The distance between y and x1 is
0.0804.
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Where to Go Next

Before continuing with the tutorial, you must set up your C compiler as
detailed in “Setting Up Your C Compiler” on page 4-13.

Setting Up Your C Compiler

If you have not already done so, you must set up your C compiler

before using codegen to compile the Euclidean example code. For most
platforms, MathWorks supplies a default compiler with MATLAB.

If your installation does not include a default compiler, for a list

of supported compilers for the current release of MATLAB, see
http://www.mathworks.com/support/compilers/current_release/ and install a
compiler that is suitable for your platform.

To set up the installed compiler:
1 At the MATLAB command line, enter:

mex -setup

2 Enter y to see the list of installed compilers.
3 Select a supported compiler.

4 Enter y to verify your choice.

Making the MATLAB Code Suitable for Code
Generation

® “Considerations for Making Your Code Compliant” on page 4-13

e “Making Your Code Suitable for Code Generation” on page 4-15
Considerations for Making Your Code Compliant
Designing for Code Generation. Before generating code, you must

prepare your MATLAB code for code generation. The first step is to eliminate
unsupported constructs.

4-13
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Checking for Violations at Design Time. You use the code analyzer in
the MATLAB Editor to check for code violations at design time, minimizing
compilation errors. The code analyzer continuously checks your code as you
enter it. It reports problems and recommends modifications to maximize
performance and maintainability.

To use the code analyzer to identify warnings and errors specific to MATLAB
for code generation, you must add the %#codegen directive (or pragma) to your
MATLAB file. A complete list of MATLAB for Code Generation code analyzer
messages 1s available in the MATLAB Code Analyzer preferences. See “Using
the MATLAB Code Analyzer Report” for more details.

Note The code analyzer might not detect all MATLAB for code generation
issues. After eliminating any errors or warnings that the code analyzer
detects, compile your code with codegen to determine if the code has other
compliance issues.

Checking for Violations at Code Generation Time. You can use
codegen to check for violations at code generation time. codegen checks that
your MATLAB code is suitable for code generation, as described in “About
Code Generation from MATLAB Algorithms” in the Code Generation from
MATLAB documentation.

When codegen detects errors or warnings, it automatically generates an error
report that describes the issues and provides links to the offending MATLAB
code. For more information, see “Code Generation Reports” .

After successful code generation, codegen generates a MEX function that you
can use to test your implementation in MATLAB.

Checking for Violations at Run Time. You can use codegen to generate
a MEX function and check for violations at run time. In simulation, the
code generated for your MATLAB functions includes the run-time checks.
Disabling run-time checks and extrinsic calls usually results in streamlined
generated code and faster simulation. You control run-time checks using the
MEX configuration object, coder.MexCodeConfig. For more information,
see “Controlling Run-Time Checks”.
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If you encounter run-time errors in your MATLAB functions, a run-time stack
appears automatically in the MATLAB Command Window. See “Debugging
Run-Time Errors”.

Where to Go Next. The next section of the tutorial, “Making Your Code
Suitable for Code Generation” on page 4-15, shows you how to use the
MATLAB code analyzer and codegen to make your code suitable for code
generation.

Making Your Code Suitable for Code Generation

To begin the process of making your MATLAB code suitable for code
generation, you work with the euclidean01.m file. This file is a MATLAB
version of a three-dimensional Euclidean example that plots the distances
between an input vector x and each of the vectors in the codebook matrix cb.
It determines which vector in cb is closest to x, and outputs this vector, its
position in cb, and the distance to y.

1 In your work folder, open euclidean01.m in the MATLAB Editor.

edit euclideanO1.m

The file opens. The code analyzer message indicator in the top right corner
of the MATLAB Editor is green, which indicates that the code analyzer
has not detected any errors, warnings, or opportunities for improvement
in the code.

a8 function [v,idx,distance] = euclidean0l (x,ch) Z-D
9 3 Initislize minimum distance as first element of ch
alf=s idx=1;

11||= distance=norm(x-ch(:,1)):

12 % Find the wvector in ch with minimum distance to x
23 = for index=Z:sizech,Z)

14 — d=normi{x-ch(:,index)):

A= if d < distance

16 — distance=d;

17 — idx=index;

18— e ————

.

2 Turn on code generation error checking by adding the %#codegen
compilation directive after the function declaration.
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function [ y, idx, distance ] =
euclidean01( x, cb ) %#codegen

The code analyzer message indicator remains green, indicating that it has
not detected any code generation issues.

For more information on using the code analyzer, see “Using the MATLAB
Code Analyzer Report” in the MATLAB Desktop Tools and Development
documentation.

3 Change the function name to euclidean02 and save the file as
euclidean02.m in the current folder.

You are now ready to compile your code using codegen, which checks that
your code is suitable for code generation. After successful code generation,
codegen generates a MEX function that you can test in MATLAB.

Generating a MEX Function Using codegen

About codegen

You generate MEX functions using codegen, a function that compiles
MATLAB code to a MEX function. codegen also checks that your MATLAB
code is suitable for code generation.

Using codegen

Because C uses static typing, codegen must determine the properties of all
variables in the MATLAB files at compile time. Therefore, you must specify
the properties of all function inputs at the same time as you compile the file
with codegen. To compile euclidean02.m, you must specify the size of the

input vector x and the codebook matrix cb.

1 Compile the euclidean02.m file.

codegen euclidean02.m -args {x(:,1), cb}

codegen reports the following error, which includes a link to the offending
line of code and a link to an error report:

??? The function 'clf' is not supported
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for standalone code generation.

See the documentation for coder.extrinsic to learn how you
can use this function in simulation.

Error in ==> euclidean02 Line: 27 Column: 1

C-MEX generation failed: Open error report.

??? Error using ==> codegen

Note that:

¢ By default, codegen generates a MEX function named euclidean02_mex
in the current folder, which allows you to test the original MATLAB code
and the MEX function and compare the results.

® The -args option instructs codegen to compile the file euclidean02.m
using the sample input parameters x(:,1) and cb.

2 Click the euclidean02 Line: 27 Column: 1 link.

The euclidean02.m file opens with the cursor at the offending line of code
in the plot_distances subfunction.

clf;

MATLAB visualization functions such as c1f are not supported for code
generation. When you call an unsupported MATLAB function, you must
declare it to be extrinsic so MATLAB can execute it, but codegen does not
try to generate code for it.

3 The functions line, grid, axis, and pause are also unsupported MATLAB
visualization functions.

Declare these functions extrinsic after the function declaration in the
subfunction plot_distances:

function plot_distances(x,cb)
% Declare extrinsic functions
coder.extrinsic('clf','line','grid', 'axis', 'pause');

4 Save the file, then recompile it.

codegen euclidean02.m -args {x(:,1), cb}
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This time codegen compiles the file without errors or warnings and
generates a MEX function euclidean02_mex in the current folder.

The Euclidean minimum distance example code is now suitable for code
generation. You are ready to begin the next task in this tutorial, “Validating
the MEX Function” on page 4-18.

Validating the MEX Function

In this part of the tutorial, you test the MEX function that you generated
in “Generating a MEX Function Using codegen” on page 4-16 to verify that
it provides the same functionality as the original MATLAB code. You run
the MEX function using the same inputs you used in “Running the Original
MATLAB Code” on page 4-10.

Running the Generated MEX Function

1 Create a single input vector x1 from the matrix x.
X1=x(:,1)
The result is the first vector in x:

x1 =
0.8568
0.7455
0.3835

2 Use the MEX function euclidean02_mex to find the vector in codebook
matrix cb that is closest to x1.

[y, idx, distance] = euclidean02_mex(x1,cb)

The MEX function runs and plots the lines from x1 to each vector in cb.
After completing the algorithm, it outputs the coordinates of the point vy,
which is the vector in cb closest to x1, together with the index idx of y in
cb, and the distance, distance, between y and x1.

y:

0.8000
0.8000
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distance =
0.0804

The plots and outputs are identical to those generated with the original
MATLAB function. The MEX function euclidean02_mex is functionally
equivalent to the original MATLAB code in euclidean01.m.

Using Build and Test Scripts

In “Generating a MEX Function Using MATLAB® Coder” on page 2-19, you
generated a MEX function for your MATLAB code by calling codegen from
the MATLAB command line. In this part of the tutorial, you use a build script
to generate your MEX function and a test script to test it. The first step

1s to modify the code in euclidean02.m to move the plotting function to a
separate test script.

Why Use Build Scripts?

A build script automates a series of MATLAB commands that you want to
perform repeatedly from the command line, saving you time and eliminating
input errors.

Why Use Test Scripts?

The euclidean02.m file contains both the Euclidean minimum distance
algorithm and the plot function. It is good practice to separate your core
algorithm from your test bench. This practice allows you to reuse your
algorithm easily. Create a separate test script to do all the pre- and
post-processing such as loading inputs, setting up input values, calling the
function under test, and outputting test results.

Modifying the Code to Remove the Plot Function
In the file euclidean02.m:

1 Delete the call to plot_distances.
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2 Delete the subfunction plot_distances.
3 Change the function name to euclidean03 and save the file as

euclidean03.m in the current folder.

Using the Build Script build01.m

Next you use the build script build01.m that compiles euclidean03.m using
codegen. This time, use the -report option, which instructs codegen to
generate a code generation report that you can use to debug your MATLAB
code and verify that it is suitable for code generation.

Contents of Build File build0O1.m

% Load the test data

load euclidean.mat

% Compile euclidean03.m with codegen

codegen -report euclidean03.m -args {x(:,1), cb}

At the MATLAB command line, enter:
buildO1

codegen runs without errors or warnings and generates a MEX function
euclidean03_mex in the current folder.

You are ready to test the MEX function euclidean03_mex.

Using the Test Script testO1.m
You use the test script test01.m to test the MEX function euclidean03x.

About the Test Script. The test script:

¢ Loads the test data from the file euclidean.mat.
¢ Runs the original MATLAB file euclidean03.m and plots the distances.

® Runs the MEX function euclidean03_mex and plots the distances.

Contents of Test Script testO1.m

% Load test data
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load euclidean.mat

% Take a single input vector from the matrix x
x1=x(:,1);

% Run the original MATLAB function
disp('Running MATLAB function euclidean03');
[y, idx, distance] = euclidean03(x1,cb);

disp(['y = ", num2str(y')]);
disp(['idx = ', num2str(idx)]);
disp([‘'distance = ', num2str(distance)]);

% Visualize the distance minimization

% plot_distances

clf;

for index=1:size(cb,2)

line([x(1,1) cb(1,index)], [x(2,1) cb(2,index)],
[x(3,1) cb(3,index)]);

end
axis([0 1 01 0 1]);9rid;
pause(.5);

% Run the MEX function euclidean03_mex
disp('Running MEX function euclidean03_mex');
[y, idx, distance] = euclidean03_mex(x1,cb);

disp(['y = ", num2str(y')]);
disp(['idx = ', num2str(idx)]);
disp(['distance = ', num2str(distance)]);

% Visualize the distance minimization

% plot_distances

clf;

for index=1:size(chb,2)

line([x(1,1) cb(1,index)], [x(2,1) cb(2,index)],
[x(3,1) cb(3,index)]);

end
axis([0 1 01 0 1]);9rid;
pause(.5);

Running the Test Script. At the MATLAB command line, enter:

testO1

The test file runs, plots the lines from x1 to each vector in cb, and outputs:

Running MATLAB function euclidean03

4-21



4 1iiorial: Generating MEX Functions from MATLAB Code at the Command Line

y = 0.8 0.8 0.4
idx = 171

distance = 0.080374

Running MEX function euclidean03_mex
y = 0.8 0.8 0.4

idx = 171

distance = 0.080374

The outputs for the original MATLAB code and the MEX function are
identical.

You are now ready to begin the next task in this tutorial, “Elaborating the
Algorithm to Accept Variable-Size Inputs” on page 4-22.

Elaborating the Algorithm to Accept Variable-Size
Inputs

Why Modify the Algorithm?

The algorithm you have used so far in this tutorial is suitable only to
process inputs whose dimensions match the dimensions of the example
inputs provided using the -args option. In this part of the tutorial, you run
euclidean03_mex to see that it does not accept two-dimensional inputs. You
then recompile your code using two-dimensional example inputs and test the
resulting MEX function with the two-dimensional inputs.

About the Build and Test Scripts

Contents of test02.m

This test script creates two-dimensional inputs x2 and cb2, then calls
euclidean03_mex using these input parameters. You run this test script to
see that your existing algorithm does not accept two-dimensional inputs.

[

% Load the test data
load euclidean.mat

% Create 2-D versions of x and cb

x2=x(1:2,:);
x2d=x2(:,47);
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cb2d=cb(1:2,1:6:216);

% Run euclidean03_mex with these 2-D inputs
disp('Attempting to run euclidean03_mex with 2-D inputs');
[y, idx, distance] = euclidean03_mex(x2d,cb2d);

Contents of build02.m

This build file creates two-dimensional example inputs x2d and cb2d then
uses these inputs to compile euclidean03.m.

% Load the test data

load euclidean.mat

% Create 2-D versions of x and cb

x2=x(1:2,:);

x2d=x2(:,47);

cb2d=cb(1:2,1:6:216);

% Recompile euclidean03 with 2-D example inputs

% The -o option instructs codegen to name the MEX function euclidean03_2«
disp('Recompiling euclidean03.m with 2-D example inputs');

codegen -0 euclidean03_2d -report euclidean03.m -args {x2d, cb2d};

Contents of test03.m

This test script runs the MEX function euclidean03_2d with two-dimensional
inputs.

% Load input data

load euclidean.mat

% Create 2-D versions of x and cb

x2=x(1:2,:);

x2d=x2(:,47);

cb2d=cb(1:2,1:6:216);

% Run new 2-D version of euclidean03
disp('Running new 2-D version of MEX function');
[y, idx, distance] = euclidean03_2d(x2d, cb2d);

disp(['y = ", num2str(y')]);
disp(['idx = "', num2str(idx)]);
disp([‘'distance = ', num2str(distance)]);
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Running the Build and Test Scripts

1 Run the test script test02.m to test euclidean03x with two-dimensional
inputs.

test02

MATLAB reports an error indicating that the MEX function does not
accept two-dimensional variables for the input cb.

??? MATLAB expression 'x' is not of the correct size:
expected [3x1] found [2x1].

Error in ==> euclidean03

To process two-dimensional inputs, you must recompile your code providing
two-dimensional example inputs.

2 Run the build file build02.m to recompile euclidean03.m with
two-dimensional inputs.

build02

codegen compiles the file without errors or warnings and generates a MEX
function euclidean03_2d in the current folder.

3 Run the test file test03.m to run the resulting MEX function
euclidean03_2d with two-dimensional inputs.

At the MATLAB command line, enter:

test03

This time, the MEX function runs without errors or warnings and outputs
the vector y in matrix cb that is closest to x2d in two dimensions.

Running new 2-D version of MEX function
y =0 0.4

idx = 3

distance = 0.053094
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This part of the tutorial demonstrates how to create MEX functions to handle
inputs with different dimensions. Using this approach, you would need a
library of MEX functions, each one suitable only for inputs with specified data
types, dimensions, and complexity. Alternatively, you can modify your code
to accept variable-size inputs. To learn how, see “Specifying Variable-Size
Inputs” on page 4-25.

Specifying Variable-Size Inputs

The original MATLAB function is suitable for inputs of any data type,
dimensions, and complexity. To provide this same flexibility in your generated
C code, use coder.typeof with the codegen -args command-line option.

coder.typeof(a,b) specifies a variable-size input with the same class and
complexity as a and same size and upper bounds as the size vector b. For more
information, see “Specifying Variable-Size Inputs at the Command Line”.

1 Compile this code using the build file build03.m. This build file uses
coder.typeof to specify variable-size inputs to the euclidean03 function.

build03

codegen compiles the file without warnings or errors and generates a MEX
function euclidean03_varsizex in the current folder.

2 Run the resulting MEX function with two-dimensional and then
three-dimensional inputs using the test file test04.m.

At the MATLAB command line, enter:
test04
The test file runs and outputs:

Running euclidean03_varsizex with 2-D inputs
y =0 0.4

idx = 3

distance = 0.053094

Running euclidean04_varsizex with 3-D inputs
y = 0.6 0.8 0.2

idx = 134

distance = 0.053631
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You have successfully created an algorithm that accepts variable-size
inputs.

Specifying Upper Bounds for Local Variables

In this part of the tutorial, you modify the algorithm to compute only the
distance between the first N elements of a given vector x and the first N
elements of every column vector in the matrix cb.

To modify the Euclidean minimum distance algorithm, euclidean03.m, to
accommodate changes in dimensions over which to compute the distances:

1 Provide a new input parameter, N, to specify the number of elements to
consider. The new function signature is:

function [y,idx,distance] = euclidean03(x,cb,N)

2 Specify an upper bound for the variable N using assert. Add this line after

the function declaration.

assert(N<=3);

The value of the upper bound must correspond to the maximum number of

dimensions of matrix cb. If you do not specify an upper bound, an array
bounds error occurs if you run the MEX function with a value for N that

exceeds the number of dimensions of matrix cb. For more information, see

“Specifying Upper Bounds for Variable-Size Data” in the Code Generation
from MATLAB User’s Guide.

3 Modify the line of code that calculates the initial distance to use N. Replace

the line:
distance=norm(x-cb(:,1));

with:
distance=norm(x(1:N)-cb(1:N,1));

4 Modify the line of code that calculates each successive distance to use N.
Replace the line:

d=norm(x-cb(:,index));
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with:

d=norm(x(1:N)-cb(1:N,index));

5 Change the function name to euclidean04 and save the file as
euclidean04.m in the current folder.

6 Compile this code using the build file build04.m.
At the MATLAB command line, enter:

build04

codegen compiles the file without warnings or errors and generates a MEX
function euclidean04x in the current folder.

7 Run the resulting MEX function to process the first two elements of the
inputs x and cb , then to process all three elements of these inputs. Use
the test file test05.m.

At the MATLAB command line, enter:

test05

The test file runs and outputs:

Running euclidean04_mex for first two elements of inputs x and cb
y = 0.8 0.8 0

idx = 169

distance = 0.078672

Running eucidean04_mex for three elements of inputs x and cb

y = 0.8 0.8 0.4

idx = 171

distance = 0.080374
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Key Points to Remember

Back up your MATLAB code before you modify it.

Decide on a naming convention for your files and save interim versions
frequently. For example, this tutorial uses a two-digit suffix to differentiate
the various versions of the filter algorithm.

Use build scripts to build your files.

Use test scripts to separate the pre- and post-processing from the core
algorithm.

Use the -args option to specify input parameters at the command line.

Use the MATLAB assert function to specify the upper bounds of
variable-size data.

Use the -report option to create a code generation report.

Use the coder.typeof option to specify variable-size inputs.
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Best Practices Used in This Tutorial

To see the complete list of best practices for using MATLAB for code
generation, see Chapter 5, “Best Practices for Working with MATLAB Coder”.

Best Practice — Preserving Your Code

Preserve your code before making further modifications. This practice
provides a fallback in case of error and a baseline for testing and validation.
Use a consistent file naming convention. For example, add a 2-digit suffix to
the file name for each file in a sequence.

Best Practice — Generating a Code Generation Report

Use the -report option to generate an HTML report with links to your
MATLAB code files and compile-time type information for the variables and
expressions in your code. This information simplifies finding sources of error
messages and aids understanding of type propagation rules. If you do not
specify this option, codegen generates a report only if errors or warnings
occur. For more information, see “-report Generate Code Generation Report”
on page 5-2.
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Where to Learn More

In this section...

“Next Steps” on page 4-30
“Product Help” on page 4-31
“MathWorks Online” on page 4-31

Next Steps

TO...

See...

Learn how to generate C code from your
MATLAB code

Chapter 3, “Tutorial: Generating C Code from
MATLAB Code at the Command Line”

Learn how to integrate your MATLAB code
with Simulink models

“Tutorial: Integrating MATLAB Code with a
Simulink Model for Tracking a Moving Object”
in the Simulink documentation

Learn more about using code generation from
MATLAB

Code Generation from MATLAB User’s Guide

Use variable-size data

“How Working with Variable-Size Data is
Different for Code Generation” in the Code
Generation from MATLAB User’s Guide

Speed up fixed-point MATLAB code

fiaccel in the Fixed-Point Toolbox
documentation.

Integrate custom C code into MATLAB code
and generate embeddable code

“Calling C/C++ Functions from Generated
Code”

Integrate custom C code into a MATLAB
function

coder.ceval in the Code Generation from
MATLAB documentation.

Generate HDL from MATLAB code

www.mathworks.com/products/slhdlcoder

Learn more about the best practices used in
this tutorial

Chapter 5, “Best Practices for Working with
MATLAB Coder”.



http://www.mathworks.com/products/slhdlcoder/

Where to Learn More

Product Help

MathWorks product documentation is available online from the Help menu on
the MATLAB desktop.

For... See...

Code generation from MATLAB “About Code Generation from
MATLAB Algorithms” in the
Code Generation from MATLAB

documentation.
A list of MATLAB functions that are | Code Generation from MATLAB
suitable for code generation Reference
What’s new Code Generation from MATLAB

Release Notes

MathWorks Online

For additional information and support, visit the MATLAB Coder page on
the MathWorks Web site at:

www .mathworks.com/products/matlab-coder
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Best Practices for Working
with MATLAB Coder

® “Recommended Compilation Options for codegen” on page 5-2
e “Testing MEX Functions in MATLAB” on page 5-3

¢ “Comparing C Code and MATLAB Code Using Tiling in the MATLAB
Editor” on page 5-4

e “Using Build Scripts” on page 5-5

e “Using the MATLAB Code Analyzer to Check Code Interactively at Design
Time” on page 5-7

e “Separating Your Test Bench from Your Function Code” on page 5-8
e “Preserving Your Code” on page 5-9

* “File Naming Conventions” on page 5-10
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Recommended Compilation Options for codegen

In this section...

“.¢c Generate Code Only” on page 5-2

“.report Generate Code Generation Report” on page 5-2

-c Generate Code Only

Use the -c option to generate code only without invoking the make command.
If this option is used, codegen does not generate compiled object code. This
option saves you time during the development cycle when you want to iterate
rapidly between modifying MATLAB code and generating C code and are
mainly interested in inspecting the C code.

For more information and a complete list of compilation options, see codegen.

-report Generate Code Generation Report

Use the -report option to generate a code generation report in HTML format
at compile time to help you debug your MATLAB code and verify that it is
suitable for code generation. If the -report option is not specified, codegen
generates a report only if there are compilation errors or warnings.

The code generation report contains the following information:

¢ Summary of compilation results, including type of target and number of
warnings or errors
e Target build log that records compilation and linking activities

¢ Links to generated files

¢ Error and warning messages (if any)

For more information, see codegen.




Testing MEX Functions in MATLAB®

Testing MEX Functions in MATLAB

To prepare your MATLAB code before you generate C code, use codegen
to convert your MATLAB code to a MEX function. codegen generates a
platform-specific MEX-file, which you can execute within the MATLAB

environment to test your algorithm.

For more information, see codegen.
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Comparing C Code and MATLAB Code Using Tiling in the

MATLAB Editor

Use the MATLAB Editor’s left/right tile feature to compare your generated C

code to the original MATLAB code. You can easily compare the generated C

code to your original MATLAB code. In the generated C code:

® Your function name is unchanged.

® Your comments are preserved in the same position.

To compare two files, follow these steps:

1 Open the C file and the MATLAB file in the Editor. (Dock both windows if

they are not docked.)

2 Select Window > Left/Right Tile (or the ﬁ toolbar button) to view

the files side by side.

The MATLAB file kalman02.m and its generated C code kalman02.c are
displayed in the following figure.

SMAdoc\matlab\doc\src\toolbox\ codergs\exarnplesikalman'kalman02.m

-] function ¥ = kalman02 (z) %#cod
El ialize state tran
10 -
11 - 0dc 0 0O0:r...
12 010dc 0O0:...
13 0010dt 0r...
14 00010dt;...
15 000010 ;...
16 0O0D00O021]:
17
18 % Measurement matrix
= H=[100000;0100001]:
20 = Q = eve(6):
21 - R = 1000 * eye(2);
22
23 % Initial conditi
24 — persistent x_est
25 — if isempty(x_s=T)
26 — ¥ =3t = zeros(e, 1);
27 — p_e3t = zeros (6, 6):
28 — end
29
< m

O » x  Sh\Adocdimatlabh\docisrd\toolboxcoder\gsh\examples\kalmantbuild02\kalman02.c
|

~ 26 void kalman02 (const real T z[2], real T y[2])
27 {
28 int32_T r3;
29 ints_T Q[36];
30 int32 T rl:
31 real T x prd[6]:
32 static int8 T iv0[36] = { 1, 0, 0, O, O, 0O, O,
33 ¢, 1, 0, 1, 0, 0, 0, 0, 1, 0, 1, ©, @, 0, O,
= 34
35 real T klm gain[36];
36 int32 T ki
37 real T a2l:
38 static int8 T ivi[36] = { 1, 0, 1, 0, 0, 0, O,
39 o, o, 0, 1, 0, 1, 0, o, o, 0, 1, 0, 0, 0, @O,
40
41 real T p_prd[36];
42 real T b_klm gain[12];
43 gractic incd T iv2[12) = { 1, 0, O, 1, O, O, Q,
44
45 statiec int8 T iv3[12] = { 1, 0, O, O, O, O, O,
46
- 47 static intlé6_T iv4[4] = { 1000, 0, O, 1000
3 4 11

m
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Using Build Scripts

Using Build Scripts

If you use codegen to generate code from the command line, use build scripts
to call codegen to generate MEX functions from your MATLAB function.

A build script automates a series of MATLAB commands that you want to
perform repeatedly from the command line, saving you time and eliminating
input errors. For instance, you can use a build script to clear your workspace
before each build and to specify code generation options.

Here is an example of a build script to run codegen to process 1ms_02.m:

close all;
clear all;
clc;

N = 73113;

codegen -report lms_02.m
-args { zeros(N,1) zeros(N,1) }

where:

® close all deletes all figures whose handles are not hidden. See close in
the MATLAB Graphics function reference for more information.

e clear all removes all variables, functions, and MEX-files from memory,
leaving the workspace empty. It also clears all breakpoints.

Note Remove the clear all command from the build scripts if you want
to preserve breakpoints for debugging.

¢ clc clears all input and output from the Command Window display, giving
you a “clean screen.”

® N = 73113 sets the value of the variable N, which represents the number of
samples in each of the two input parameters for the function 1ms_02

® codegen -report lms 02.m -args { zeros(N,1) zeros(N,1) } calls
codegen to generate C code for file Ims_02.m using the following options:
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= -report generates a code generation report

-args { zeros(N,1) zeros(N,1) } specifies the properties of the
function inputs as a cell array of example values. In this case, the input
parameters are N-by-1 vectors of real doubles.

5-6



Using the MATLAB® Code Analyzer to Check Code Interactively at Design Time

Using the MATLAB Code Analyzer to Check Code
Interactively at Design Time

The code analyzer checks your code for problems and recommends
modifications to maximize performance and maintainability. You can use
the code analyzer to check your code continuously in the MATLAB Editor
while you work.

To ensure that continuous code checking is enabled:

1 From the MATLAB menu, select File > Preferences > Code Analyzer.
The list of code analyzer preferences appears.

2 Select the Enable integrated warning and error messages check box.
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Separating Your Test Bench from Your Function Code

If you use codgen to generate code from the command line, separate your core
algorithm from your test bench. Create a separate test script to do all the pre-
and post-processing such as loading inputs, setting up input values, calling
the function under test, and outputting test results.



Preserving Your Code

Preserving Your Code

Preserve your code before making further modifications. This practice
provides a fallback in case of error and a baseline for testing and validation.
Use a consistent file naming convention. For example, add a 2-digit suffix to
the file name for each file in a sequence. See “File Naming Conventions” on
page 5-10 for more details.
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File Naming Conventions

Use a consistent file naming convention to identify different types and
versions of your MATLAB files. This approach keeps your files organized
and minimizes the risk of overwriting existing files or creating two files with
the same name in different folders.

For example, the file naming convention in the Generating MEX Functions
getting started tutorial is:

® The suffix _build identifies a build script.
¢ The suffix _test identifies a test script.

¢ A numerical suffix, for example, 01 identifies the version of a file. These
numbers are typically two-digit sequential integers, beginning with 01,
02, 03, and so on.

For example:

® The file build_01.m is the first version of the build script for this tutorial.
® The file test_03.mis the third version of the test script for this tutorial.
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Examples

Use this list to find examples in the documentation.



A Examples

Getting Started

Chapter 2, “Tutorial: Generating C Code from MATLAB Code Using the
MATLAB® Coder Project Interface”

Chapter 3, “Tutorial: Generating C Code from MATLAB Code at the
Command Line”

Chapter 4, “Tutorial: Generating MEX Functions from MATLAB Code at
the Command Line”
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